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Welcome to Axiom Axiom
Axiom Strategy Management is a component of the Kaufman Hall Axiom Healthcare Suite of financial
solutions. The Axiom Healthcare Suite products support an iterative, continuous cycle in which strategic
plans define day-to-day operational targets while operational data informs long-term strategic planning.
Axiom Strategy Management supports this process by giving you the tools needed to monitor and
manage howwell your organization’s day-to-day activities align with its strategic plans, and the goals and
processes that support them. Axiom Strategy Management enables you to translate strategy to
execution in a measurable way, then feed thosemeasurements back into the system to improve financial
outcomes and overall organizational efficiency and productivity.

What is covered in this document
This manual is written for Axiom Strategy Management Administrators. These individuals in your
organization are tasked with configuring, maintaining, and controlling other users' access to Axiom
Strategy Management-related features and data.

As an administrator, you have access to features and menus that are unavailable to regular end users
such as department managers, non-finance executives, and other stakeholders. In some cases, the same
screen or workbook might display slightly different in your interface than it would for an end user.

What’s new
Welcome to Version 2019.4 Axiom Strategy Management!

Enhancements and changes in this release include:

l Home page redesign – The Home page for theWindows and Excel clients has been updated with
the current Axiom logo and a new look-and-feel.

Redesigned Home page for Windows and Excel clients
The default home page used in theWindows and Excel clients has been updated with the current Axiom
logo and a new look-and-feel.

1
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Implementing best practices for Axiom Strategy
Management

Though Axiom Axiom is highly configurable, it does make a few general assumptions about how your
organization should structure the strategy management process.

While every organization's situation is unique, it has been our experience that organizations typically get
the best results when their strategy management process:

l Receives full support from a well-informed management team.
l Is rigorous and highly organized.
l Links financial planning and capital planning to the organization’s strategic plan.

l Encourages rational comparisons between projects and strategic initiatives throughout the entire
organization.

l Provides a financial context for allocation decisions.

l Accounts for the strategic, mission, and operational aspects of alternative investment decisions.

Understanding Axiom StrategyManagement
Axiom Software products store your organization's data (financial data, labor data, key statistics, and so
on), in a central database, and then pull that data into the interface where you can view, enter, or modify
the data using familiar spreadsheet commands. Axiom Strategy Management also provides a
spreadsheet-based interface from the Desktop Client, but except for a few administrative tasks, you can
access features and functions through theWeb Client. Themajority of this guide covers using Axiom
Strategy Management in theWeb Client.

Axiom Strategy Management basic components
Axiom Strategy Management picks up where your mission statement leaves off. The system consists of
threemain levels: Perspectives, Objectives, and Initiatives. Each level in the strategy hierarchy is
supported by the ones below it. The following graphic is simplified to illustrate the different levels, but in
reality, Perspectives can havemultiple Objectives, and Objectives can havemultiple Initiatives. Measures
are applied to each element at each level in the hierarchy, and so support the entire hierarchy.
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Perspectives – Strategic pillars that uphold
your organization’s mission. For example,
if your organization is a hospital, one of
your Perspectives might be Clinical
Performance or Community Health Leader.
Each Perspective has one or more
associated Objectives.

Objectives – Goals that support your
organization’s Perspectives. Each
Objective belongs to only one Perspective.
Each Objective is associated with one or
more Initiatives.

Initiatives – Processes and procedures
that employees perform to support the
Objectives. Each Initiative belongs to only
one Objective.

Measures – Data collectors used to
determine the performance status of the
items to which they are applied.

As illustrated by the process diagram at the
bottom of the graphic, each measure
collects data that the system uses to
determine howwell the strategy elements
are performing. Based on this analysis, the
system applies Key Performance Indicator
icons to the elements to provide at-a-
glance status updates.
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Getting Started
This chapter covers navigating the Axiom Strategy Management interface, including logging in and out of
the system and familiarizing yourself with theWeb Client and Desktop Client.

Unlike other Axiom Software products, Axiom Strategy Management is designed to be used almost
exclusively in theWeb Client. However, as an administrator, you need to be familiar with the Desktop
Client because some administrative tasks currently cannot be performed in theWeb Client.

Home page
All users have a home page that opens automatically when you log into Axiom Strategy Management.
Depending on your system, theWeb Client home pagemay be one of the following:

l A product-specific home page for an installed Axiom Strategy Management product
l A custom home page created specifically for your organization
l The default Axiom Strategy Management home page

If you navigate away from the home page, you can return to it by using the Area menu in the Global
Navigation Bar:

Home option on Area menu

If you are in a system with installed products, the Area menu may contain product names instead of the
Home item. In that case, you can select a product name to return to the home page for that product.

2
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� Default home page
If a user does not have an assigned browser-based home page, then theWeb Client displays a default
home page. The default home page displays notifications, favorites, and quick links.

Example default home page

This default home page can also be accessed (by any user) by going to the following URL:

Example On-
Premise URL

http://ServerName/Axiom/Home/Launchpage

Where ServerName is the name of the Axiom Application Server, and Axiom is the
default name of the virtual directory.

Example Cloud
System URL

https://ClientName.axiom.cloud/Home/Launchpage

Where ClientName is the name of your Axiom Cloud Service system.

This page has the following features:
l Notifications: You can read and delete notifications using the same features available in the

Notifications panel.

l Quick Links: You can use a set of global quick links that are displayed here for easy access. These
links are built-in to the page and cannot be customized. However, the link to the Excel Client may
not be present if your system has been configured to hide it.

l Favorites: You can open and delete web favorites.

Administrator's Guide Axiom Strategy Management │ 10



Launching Axiom StrategyManagement applications
You can launch various Axiom Strategy Management applications from theWeb Client Quick Launch
menu, including the Axiom Excel Client and AxiomWindows Client.

The Quick Launch menu serves the following purposes:
l Users can install applications from this area as needed. Afterward, they can continue to launch

installed applications from this location, or they can use other options (such as a shortcut on their
desktop).

l For systems using SAML or OpenID authentication, this is the only option for users to launch
installed applications. SAML and OpenID authentication require users to be authenticated using
theWeb Client before they can launch a desktop application.

l Users can install and launch add-ins such as the add-ins for Microsoft Office applications.

To open the Quick Launch menu, click the Quick Launch icon in the Global Navigation Bar.

Quick Launch menu

� Launching the Axiom Desktop Client
Using the Quick Launch menu, you can launch the Axiom Desktop Client. Click on one of the following
icons:
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Item Description

Windows Client Launches the AxiomWindows Client on your desktop.

Excel Client Launches the Axiom Excel Client on your desktop. Requires Microsoft Excel.

NOTE: This option may not display in themenu, in which case you should use
theWindows Client as your desktop client.

If the client is not already installed on the current workstation, clicking the icon will initiate the install and
then launch the client. If the client is already installed, clicking the link will launch the client. You must be
using Microsoft Edge or Internet Explorer 11 (or higher) to perform these actions. Other browsers may be
able to install and launch the client if a ClickOnce extension is applied to the browser.

The appropriate client to use depends on your organization's preferences and on your user role. Your
organization will provide instruction as to which client you should use.

For more information on installing theWindows Client and Excel Client, including prerequisites and
configuration details, see the Installation Guide (on-premise systems) or the Cloud Service Technical
Guide (cloud service systems). Some software prerequisites can be downloaded and installed from the
Web Client. You can access the prerequisites download page from the Axiom Strategy Management
About box.

NOTE: The default home page also contains links to launch theWindows Client or the Excel Client.

� Launching add-ins
Using the Quick Launch menu, you can launch Axiom Strategy Management add-ins. Click on one of the
following icons:

Item Description

MSWord Add-In Launches the Axiom Strategy Management Add-In for Microsoft Word.

MS PowerPoint
Add-In

Launches the Axiom Strategy Management Add-In for Microsoft PowerPoint.

NOTE: One or both add-ins may not display in themenu, depending on your organization's
preferences.

TheWord and PowerPoint Add-ins are optional applications to support document integration between
Axiom Strategy Management and Word or PowerPoint.

Navigation panel
Using the Navigation panel, you can navigate to your documents and to various areas of theWeb Client.
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To open the Navigation panel, click themenu icon in the left side of the Task Bar. To navigate to an
area or document listed in the panel, click on the item.

Example Navigation panel

The Navigation panel updates dynamically to show the available navigation links for the currently active
area of theWeb Client. The following areas are available:

Area Description

Default Axiom Strategy Management provides a set of standard navigation links that
show by default when you are in theWeb Client. The previous screenshot
shows the standard navigation links. These links provide access to your
favorites, recent places, web-enabled reports and forms, and the Report
Designer.

The standard navigation links can be customized, so each client's system may
look different. Navigation links can only be customized by administrators using
the Desktop Client.

System
Administration

The system administration links showwhen you are in the System
Administration area, and provide access to features such as the TableManager,
Audit Manager, and software updates.

Product-Specific Systems with installed products may have product-specific web navigation links.

When you select a product name from the Area menu in the Global
Navigation Bar., the product-specific links display in the Navigation panel. For
more information, see the product-specific documentation.
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Additionally, when you open a report or other browser-based document, that document may be
associated with a set of document-specific navigation links. These links are added to the Navigation panel
while you are in that document.

Viewing system information
Use the Axiom Software About box to see information about your current system, such as:

l Axiom Strategy Management version number
l Product version numbers
l System name
l Application server URL

The About box also contains a link to download software prerequisites, if necessary for installation of the
Desktop Client.

To open the About box:

1. Click themenu icon in the Global Navigation Bar.

2. At the bottom of the Area menu, click About Axiom Software.

About Axiom Software at bottom of Area menu
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Web Client overview
Most Web Client features and navigation can be accessed using the two bars across the top of each
page:

l Global Navigation Bar: The bar at the top of the page provides access to system-level areas and
features.

l Task Bar: The gray bar underneath it provides access to various features that are specific to the
current area, page, or document.

The Global Navigation Bar and the Task Bar are available everywhere in theWeb Client except as follows:
l All areas of the Data Explorer use an older web interface. The Data Explorer has been de-

emphasized in favor of the Report Designer. Although you can still use the Data Explorer, it will not
be further enhanced.

l Axiom forms that do not have theWeb Client Container enabled. Generally speaking, this would
only be the case for legacy forms that have not yet been migrated to use the newer web interface
that was first introduced in version 2016.1.

� Global Navigation Bar
TheWeb Client Global Navigation Bar provides access to various system-level areas and features. Using
this bar, you can:

l Navigate to home, system administration, and various products (if applicable)
l Launch various client applications
l View alerts and notifications from various system processes and features
l View user information, configure session settings, and log out
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� Task Bar
TheWeb Client Task Bar provides access to various features that are specific to the current area, page, or
document. Using this bar, you can:

l Navigate to your browser-based files and related areas of theWeb Client
l Filter the data shown on the current page
l Comment on the current document and review comments from others
l Access tools relating to the current document or area
l Save the current page or document as a favorite
l View help for Axiom Strategy Management or for the current document
l Perform other context-sensitive tasks such as managing attachments or working with the Report

Designer
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The left-hand side of the task bar contains a task toolbar. You can click on any icon in this toolbar to open
the panel for the associated feature. For example, clicking the filter icon opens the Filters panel. Clicking
the icon again closes the panel.

The panel can be pinned or unpinned using the pin icon in the top right of the panel. If the panel is
unpinned, the panel overlays the current page contents, and clicking on the page closes the panel. If the
panel is pinned open, then the form is pushed to the side so that the panel contents and the form can be
viewed at the same time. When pinned, clicking on the page does not close the panel—you must unpin
the panel or click the toolbar icon again to close the panel.

The contents of the task bar vary depending on the current page or document. For example, the
Message Stream and the Filters panel are only available if they have been enabled for the current
document. If a particular feature is not available for a particular document or area, then either it has not
been enabled or it does not apply.

Viewing notifications in the Web Client
If you receive a notification in Axiom Strategy Management, you can view it in the Notifications panel.
Notifications can come from the following sources:

l Alert notifications. Your system administrators and other power users may have set up alerts to
monitor certain alertable conditions and then notify specified users.

l Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

l Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

l Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Strategy Management will notify you when the process is completed or when
errors occur.

To open the Notifications panel, click the Notifications icon in the Global Navigation Bar.

Example Notifications panel
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If you have new, unread notifications when you first log in, or if you receive new notifications during a
current session, a red number displays on the Notifications icon. Unread notifications are indicated by a
blue bar along the left-hand side of the notification. Once a notification has been read, the bar is
removed.

NOTES:
l Your notifications may also display on your home page. If so, the notifications can be read and

managed using the same features described here.

l All notifications displayed in the Notifications panel are also available in the Notifications task
pane of the Desktop Client. Both areas read from the same source of notifications, and edit
the same source as well. If you mark a notification as read in one area, or delete a notification
from one area, the other area will reflect these changes.

� Reviewing notifications
Within the panel, notifications are listed in the order they were received, with the newest notifications at
the top. You can click the All, Unread, and Read links at the top of the panel to indicate which
notifications you want to see in the panel. By default, the panel shows all notifications. When you click
on a notification, it is automatically marked as read.

Notifications may display with the following icons:

Notification about a comment posted to theMessage Stream.

Notification with "information" priority.

Notification with "warning" priority.

Notification with "error" priority.

If the notification contains more content than can be displayed within the summary view, then you can
view the full notification as follows:

l Hover your cursor over the notification to display the action icons at the top right.
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l Click themagnifying glass icon to open the full notification in a dialog.

Additionally, some notifications contain links to documents that you can open for more information.

� Notification actions
Hover your cursor over themenu icon in the top right of the Notifications panel to perform the
following actions:

l Select All: Select all notifications that are currently showing in the panel.
l Mark Read: Mark the selected notifications as read.
l Mark Unread: Mark the selected notifications as unread.
l Delete: Delete the selected notifications. Keep in mind that once a notification has been deleted,

you cannot undo this action. You can also delete a notification by hovering your cursor over the
notification, then clicking the delete icon .

Managing favorites in the Web Client
You can save Axiom files and Web Client pages as favorites, for quick access to commonly used items.
Your favorites list is available in the following locations:

l The Navigation panel
l The default Web Client home page
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Example favorites in Navigation panel

Your favorites list displays any favorites that you have saved in theWeb Client. It also displays web-
enabled favorites that you have saved in the Desktop Client (meaning favorites to individual Axiom forms
or web reports). Other favorites saved in the Desktop Client do not display in theWeb Client (including
folders saved as favorites, even if the folder contains web-enabled files).

� Saving favorites
To save the current document or page as a favorite in theWeb Client, click the star icon in the right side
of the Task Bar. The star icon toggles from outline (not a favorite) to filled (a favorite).

Favorite icon in Web Client task bar

Once a favorite has been saved, it displays in your favorites list in theWeb Client and in the Desktop
Client. You can use the saved favorite to quickly open the document or page.

Web favorites are saved using the name shown in the browser tab. Web reports and Axiom forms
support the ability to define a title that displays in the browser tab, which means the title may be
different than the file name. If the title is changed after the favorite is saved, the favorite does not update
to show the changed title (however, the favorite still works to open the specified document).
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Currently, theWeb Client does not support the ability to rename or reorder web favorites, or to organize
web favorites into folders. Web favorites display as a flat list, in alphabetical order. However, if you
rename a favorite in the Desktop Client, theWeb Client updates for the new name.

NOTES:
l When favorites are saved in theWeb Client, they are saved as URLs instead of as document

shortcuts. This allows you to save any page in theWeb Client as a favorite, not just
documents. For example, if you have access to the Audit Manager, you can save that as a
favorite for quick access to the page. However, if the name of your Axiom Strategy
Management virtual directory ever changes (which should be a rare occurrence), the web
favorite will no longer work.

l If a web favorite points to a document, and that document is later moved or renamed, the
favorite will continue to open that document (but the favorite name is not updated).

l If you organize web favorites into a folder using the Desktop Client, the folder will display in
the favorites list in theWeb Client Navigation panel. However, the favorites list is flattened for
display in theWeb Client home page.

� Deleting favorites
To delete a favorite, hover your cursor over the favorite name (in either the Navigation panel or your
home page), then click the delete icon . The favorite is deleted in theWeb Client and in the Desktop
Client.

If the document or page for an existing favorite is deleted, the favorite is not automatically deleted. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Viewing page content
All Axiom Strategy Management users have access to all main pages except the Admin pages, which are
available only to Strategy Management administrators. What you can see on each page depends on
your access rights, which are determined by your user roles and whether you are designated as an owner
or sponsor for any Initiatives. For example:

l All users can see Objective names, but only users with the Strategy Management Admin role, or
the Strategy Management Executive role can view all Objective information and Objective
measure data. Objective owners can also view information and measure data for Objectives that
they own.

l If you are designated as the owner or sponsor of an Initiative, you can see information related to
that Initiative, but not other Initiatives.

l If you have the Initiative Approver or Initiative Creator user role, you can view all Initiative
information.
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Using the Desktop Client
Although most of the features in Axiom Strategy Management are available from theWeb Client, if you
are a system administrator or are using certain reports, you may need to use the Desktop Client
occasionally; for example, when assigning security roles to users.

All Axiom Software products, including Axiom Strategy Management, share a common interface and use
many of the same features. The interface includes the following common sections.

� Display area
Themain area of the Desktop Client displays open files. By default, it shows the Axiom Strategy
Management Dashboard. The display here is essentially identical with the one in theWeb Client; the only
pieces missing are the side navigation panel, replaced by the Axiom Assistant pane; and theWeb Client
toolbars. If you click any links in the Dashboard, they behave the same as in theWeb Client—they either
open a window or open the corresponding Axiom Strategy Management Web Client page. To work
within the Desktop Client, use the task panes.

� Task panes
A task pane provides access to commands, utilities, reports, plan files, and so on for Axiom Strategy
Management, and displays on the left side of themain display area. To switch between task panes, click
the tabs on the left side of the interface. To expand or collapse the task panes, click the arrow in the left-
hand corner above the tabs.

Administrator's Guide Axiom Strategy Management │ 22



Administrator's Guide Axiom Strategy Management │ 23



� Ribbon tabs
Ribbon tabs provide access to commonly used features and shortcuts to frequently accessed files. They
display above the task pane and main display areas. The role assigned to you determines the ribbon tabs
that display. For example, the Admin ribbon tab only displays to those users assigned the Administrator
role profile.

NOTE: The role assigned to you determines the ribbon tabs that display. For example, the Admin
ribbon tab only displays to those users assigned the Administrator role profile.

Administrator's Guide Axiom Strategy Management │ 24



� Main
Includes commands for accomplishing most tasks in Axiom:

l Opening, closing, and saving files
l Viewing data in spreadsheets (if you have access rights to do so)
l Printing or emailing files
l Accessing shortcuts to frequently accessed reports

� Home
Includes standard spreadsheet commands.

Some options on the ribbon tabs display grayed out unless certain types of files such as reports or plan
files are currently open, or if you do not have the necessary security permissions to use the feature.

The Excel Client displays all of the same ribbon tabs included in a normal Excel file. TheWindows Client
only includes a subset of the same ribbon tabs located in the Home ribbon tab.

TIP: When creating reports, we recommend that you use the Excel Client.

� Windows Client or Excel Client?
The following table describes each client:
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NOTE: All Axiom Strategy Management web pages are configured for viewing in theWeb Client. You
can view the Dashboard in theWindows and Excel clients, but if you click a link to another page from
a Dashboard link, you cannot navigate back.

Type Description

Windows Client l Emulates a spreadsheet environment without requiring
Excel.
o Provides access to some Axiom Strategy Management

features.
o Navigation and help functions differ from the Excel

Client.

l Communicates with the database using http or https.
l Administrative rights not required for local installation or

updates.
l Users with appropriate permissions can open standard

Excel files from within theWindows Client.
l Provides faster processing speeds and fewer technical

requirements than the Excel Client.
l Access to features in this client depend on user access

permissions

Excel Client l Provides access to all of the Axiom Software features within
a Microsoft Excel interface.

l Communicates with the database using http or https.
l Administrative rights are not required for local installation

or updates.
l Users with appropriate permissions can open and create

any normal Excel file and perform Excel tasks without
needing to exit the Excel Client.

NOTE: The instructions in this website, including the screenshot examples, assume that your
organization is using theWindows Client. The Excel Client uses the same features, but with the added
benefit of the Excel interface, including the Excel ribbon tab.

Opening the Explorer task pane
Axiom Strategy Management provides a built-in Explorer task pane so that you can quickly access your
favorites, recent items, and all the files that you have rights to access.
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TIP: You can also access Favorites, Recent, and My Documents from theMy Files and Tasks task
pane.

By default, all users are given access to this task pane. If desired, administrators can disable use of this
task pane entirely, or restrict access to certain sets of users.

To access the Explorer task pane:
l In theMain ribbon tab, click Navigation, and select Explorer.
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Accessing Axiom Strategy Management features
In Axiom Strategy Management, admins and non-admin users access main features and functionality in
the Desktop Client from the Explorer task pane. However, your user role(s) determines which features
you can access. You may not have access to all the features listed here.

To access Axiom Strategy Management File groups:
1. In the Explorer task pane, expand the File Groups section.

2. Scroll down to and expand Strategy Management - Requests.

To access Axiom Strategy Management Reports:
1. In the Explorer task pane, expand the Libraries section.

2. Expand the Reports Library.

3. Scroll down to and expand Strategy Management Reports.

To access Axiom Strategy Management utilities:
1. In the Explorer task pane, expand the Libraries section.

2. Expand the Reports Library.

3. Scroll down to and expand Strategy Management Utilities.

4. Expand Utilities.

NOTE: You can also access Axiom Strategy Management Home pages by expanding Home
Pages.

To access Axiom Strategy Management Scheduler Jobs:
1. In the Explorer task pane, expand the Libraries section.

2. Expand the Scheduler Jobs Library.

3. Expand Strategy Management.

NOTE: System administrators can access the following Scheduler jobs: SM_CreatePlanFiles,
UpdateMeasureData-SQL, and UpdateMeasureTarget-SQL

To access Axiom Strategy Management strategy hierarchy tables:

NOTE: Only administrators can access the Initiative and Objective tables.

1. In the Explorer task pane, expand the Libraries section.

2. Expand the Table Library.
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3. Expand !Dimensions and then do any of the following:
l To access the Initiative table, scroll down to and double-click Initiative.
l To access theMeasure table, scroll down to and double-clickMeasure.
l To access the Objective table, scroll down to and double-click Objective.
l To access the Perspective table, scroll down to and double-click Perspective.

To access Axiom Strategy Management Data tables:

NOTE: Only administrators can access the Data tables.

1. In the Explorer task pane, expand the Libraries section.

2. Expand the Table Library.

3. Expand Strategy Management.

4. Expand Data.

5. To open the desired table, double-click it.

Axiom Assistant task panes
The Axiom Assistant area provides quick and easy access to Axiom Strategy Management files and
features as you work in the Desktop Client. A variety of task panes are available to help you perform
general and context-sensitive tasks. Additionally, system administrators can create customized task
panes for use in this area.

The Axiom Assistant area is located in the left-hand side of the application, below the ribbon and to the
left of any opened files. By default, the area is expanded, and you can work with any of its available task
panes by clicking the side-tabs along the left-hand edge of the pane.
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Example Axiom Assistant area

� Available task panes
The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane Description Availability

Data Source
Assistant

Helper tool to build data sources, such
as RefreshVariables, DataLookup, and
Grid.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is an
Axiom file.

Explorer Open files and other items that you
have access to, including favorites.

This task pane is included by default, but
may be disabled in your system or
restricted to only certain users.

File
Processing

Configure and perform file processing
for an Axiom file, such as to perform
multipass processing, file collect, or
batch processing.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for File Processing.

Form
Assistant

Configure form settings for an Axiom
file, and preview the form.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for Axiom forms.
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Task pane Description Availability

Messages View comments about the current
document, and add comments.

This task pane is system-controlled and
displays for all eligible documents.

Notifications View alert and system notifications and
open associated files.

This task pane is system-controlled and
displays if you have any active
notifications.

Process View process information and complete
process tasks. By default this task pane
only displays if it is relevant to you (for
example if you are the assigned owner
of a process task).

This task pane is included by default, but
may be disabled in your system.

Sheet
Assistant

Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

Table View table details, set a filter, and
refresh the currently opened table.

This task pane is system-controlled and
displays when using Open Table in
Spreadsheet.

<Custom
Task Panes>

Your organization may have defined
one or more custom task panes for
your system.

Custom task panes may open
automatically when Axiom Strategy
Management is launched, or you may
have access to the Task Panes Library to
open certain task panes as needed.

The order of task panes in the Axiom Assistant area cannot bemanually changed. Your system
administrator has specified an order for the task panes that open when the system is started. System-
controlled task panes display after these startup task panes.

� Minimize Axiom Assistant
By default, the Axiom Assistant area is maximized when you first start Axiom Strategy Management. If
desired, you can minimize this area—for example, to gain more screen space while working on a file.
When minimized, the area displays as a thin strip along the left-hand side of the application, with one or
more side-tabs for each task pane.

You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

l To minimize the Axiom Assistant pane, click the button in the header.

l To expand the Axiom Assistant pane, click the button in the collapsed header, or click on one of
the task pane tabs.
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Axiom Strategy Management remembers the state of the Axiom Assistant (minimized or expanded) when
you exit the application, and will apply that state the next time you open Axiom Strategy Management
on the samemachine.

It is not possible to completely hide the Axiom Assistant area when task panes are open, however, if no
task panes are open then the Axiom Assistant area is automatically hidden (and will automatically show
again when a task pane is opened).

� Opening task panes
In most cases, the task panes that you need to use will open automatically—you do not need to
manually open them.

l Certain task panes are configured to open automatically when Axiom Strategy Management is
started, such as the Explorer task pane. These task panes are considered to be "global" task panes
that you may want to use at any timewhile you work in the system.

l Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it will always be available when it is relevant
(and assuming that you have security permissions to view it).

If you have access to the Task Panes Library to open certain custom task panes as needed, then you can
open a task pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog.
Alternatively, one of your "startup" task panes might be used to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps you need to
do to run your monthly reports, and links to those reports. You wouldn't necessarily need this task pane
to be open at all times; instead, you would only want to see it when you are ready to process your
monthly reports. You could open the task pane as needed from the Task Panes Library or from another
custom task pane that links to it.

� Closing task panes
Most task panes cannot bemanually closed. Either they are global task panes that always apply, or they
are context-sensitive task panes that close automatically when the associated file or feature is closed.
Alternatively, you can minimize the Axiom Assistant area to "hide" all task panes and gain more screen
space for your open files.

If a task pane is closeable, then you can close it by clicking the X icon on the side-tab for the task pane. If
this icon is not present, then the task pane cannot be closed. Typically, only task panes that you open
manually can be closed manually, but in some cases you may also be able to close task panes that open
on startup.
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� Using task panes in the Axiom Excel Client
When using the Axiom Excel Client, each file opens within its own window, and each windowmaintains its
own set of ribbon tabs and task panes. This means that as you switch windows, the set of task panes
available in each windowmay be different. For example:

l If you manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

l The currently active task pane is managed independently for each window, so the active task pane
may change as you change windows. (This can also occur when using the AxiomWindows Client, if
you switch between files that have different default task pane associations. However, in the Axiom
Excel Client it may also happen when switching between files with the same default task pane
associations.)

l The current state of task panes is managed independently for each window. For example, if you
expand the Reports Library in the Explorer task pane in one window, that expansion will not be
present if you switch to a different window.

Managing favorites
You can save Axiom files and other items as favorites, for quick access to commonly used items. In the
Desktop Client, your favorites list is available in the following locations:

l The Explorer task pane in the Axiom Assistant area
l The Axiom Explorer dialog (if you have permission to access this dialog)

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands that would be available on the item in its native area. For example, if you
have rights to the Table Library and you save a table as a favorite, you can right-click the table favorite
and perform actions such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it. If you attempt to open an invalid favorite, a message box informs you that the item
has been deleted, and asks whether you want to delete the favorite. If a file is moved or renamed within
the Axiom Software file system, but it retains the same document ID, then the shortcut will not be
broken.
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� Saving and deleting favorites
You can save an item as a favorite in one of the following ways:

l In the Explorer task pane and the Axiom Explorer dialog, you can right-click an item and select
Add to Favorites.

l When a file is open, you can right-click the file tab and select Add to Favorites.

The item is saved as a favorite and now displays in your Favorites list. If the file was open when you saved
it as a favorite, it displays using the file tab name. If needed, you can change the display name by editing
the shortcut properties for the favorite.

TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used will be automatically saved as part of the favorite, in the
shortcut properties. You may want to rename the favorite to indicate the particular settings (for
example: GL2019 - Filtered for North Region).

NOTE: If a web-enabled file is saved as a favorite in the Desktop Client, that favorite will also display in
theWeb Client. This includes Axiom forms and web reports. All other types of favorites do not display
in theWeb Client.

To delete a favorite, right-click the item and then select Delete.

� Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag and drop individual favorites to change the order. Sub-folders cannot
be reordered—they will always display in alphabetical order.

To rename a favorite, right-click the item and then select Rename. The name becomes editable, and you
can type a new name.

� Shortcut properties
You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut Properties.
In this dialog, you can edit the shortcut name, change the shortcut target, and define certain shortcut
properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.
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� Using web favorites in the Desktop Client
If you save a favorite in theWeb Client, that favorite also displays in the Desktop Client favorites list. You
can double-click the web favorite to open it in theWeb Client browser.

When a favorite is saved in theWeb Client, it is stored as a URL instead of a document shortcut. If the
target of the favorite is later deleted, the favorite does not show as invalid in the Desktop Client. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Opening recent files
Axiom Strategy Management maintains a list of your recently opened files in the Desktop Client. You can
use this list for quick access to recent files.

The recent file list is located in theMy Files section of the Explorer task pane and Axiom Explorer. You can
double-click files to open them, or right-click to access the context menu for the file type. Recent files are
listed using the file tab name that they were opened with, which may or may not be the same as the file
name.

The list displays the last 15 files that you recently opened. Note the following:
l If you want to clear the list, right-click Recent and select Clear History.
l If you want to continue to have quick access to a recent file, you can add it to your favorites.

Right-click the file and select Add to favorites.
l If the icon next to a file name is a red arrow, this means that the file has been moved or deleted

since you accessed it, so it can no longer be opened from the recent file list.

In the AxiomWindows Client only, recent files can also be accessed from the Filemenu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
Strategy Management database. Therefore, Excel's recent file list cannot be used to open Axiom files.

Viewing notifications using the Notifications task pane
If you receive an Axiom Strategy Management notification, the notification displays in the Notifications
task pane. This is a system-controlled task pane that is always available in the Desktop Client if you have
notifications. Click theNotifications tab in the Axiom Assistant area to view the task pane.
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Example Notifications task pane

If you have unread notifications when you first log in, or if you receive new notifications during a current
session, the Notifications tab will flash orange and remain that color until you click on the tab. Unread
notifications display in bold text. Once a notification has been read, the bolding is removed.

Notifications can come from the following sources:
l Alert notifications. Your system administrators and other power users may have set up alerts to

monitor certain alertable conditions and then notify specified users.

l Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

l Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

l Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Strategy Management will notify you when the process is completed or when
errors occur.
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NOTES:
l The Notifications task pane is a system-controlled task pane; you cannot hide or show this

task panemanually. The Notifications task pane always displays on startup if you have any
active notifications (read or unread). Otherwise, it does not display. If you receive a new
notification during a session and the task pane is not already open, this will cause the task
pane to open.

l All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the AxiomWeb Client. Both areas read from the same source of notifications, and edit
the same source as well. So if you mark a notification as read in one area, or delete a
notification from one area, the other area will reflect these changes.

� Reviewing notifications
Within the task pane, notifications are listed in the order they were created, with the newest notifications
at the top. Each notification displays a severity icon and an alert title, as well as how old the notification
is. The following severity icons are used:

l Info

l Warning

l Error

To read the notification text, double-click the notification to expand it. The text should provide you with
more information about the notification and why you are receiving it. You can double-click the
notification again to collapse it.

If the notification is from an alert, then the alert creator may have specified a document that you can
open to seemore information about the alert condition. If so, then you will see an Open link underneath
themessage text when you expand the notification. Click this link to open the associated document.

� Notification actions
You can select one or more notifications and then right-click to perform the following additional actions: 

l Mark Read: Mark the selected notifications as read.
l Mark Unread: Mark the selected notifications as unread.
l GoTo Alert Definition: Open the source document for the alert, if you have permission to access

the file. You will be taken directly to the specific alert definition that generated the notification.
l Delete: Delete the selected notifications. Keep in mind that once a notification has been deleted,

you cannot undo this action.
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Commenting on documents using the Message Stream task pane
When viewing a spreadsheet Axiom file within the Desktop Client, you can view comments that other
users havemade about the document and also make comments about the document. New comments
are stored in themessage stream for that document, so that all other users who access the document
can see the comment. Additionally, you can "tag" other users in the comment, so that the tagged users
are notified about the comment.

You can view comments and add comments using theMessage Stream task pane. This is a system-
controlled task pane that automatically opens for eligible documents.

NOTES:
l Themessage stream is only available for documents where it has been enabled.

l Themessage stream is also available for Axiom forms that are open within the Desktop Client,
using theMessage Stream panel. This panel is accessible from the task bar displayed across
the top of the form.

� Viewing the message stream
To view themessage stream for the current document, click theMessage Stream tab to display the task
pane in the Axiom Assistant sidebar. This task pane shows all comments that have been made about the
document.

Example message stream

Comments are displayed in the order they weremade, with themost recent comment shown at the top
of the panel. Each comment shows when the comment was made and the user who made it.
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To view the full text and details of a comment, hover your cursor over the comment so that the > symbol
displays on the right-hand side of the comment. Click the symbol to open a separate Comment Details
dialog with the full comment text.

Once themessage stream has been loaded for the current document, it is only updated automatically
after you add a new comment. If necessary, you can manually refresh the task pane to see if any other
users havemade comments during the current file session.

Comments are stored for the life of the document, and cannot be deleted.

� Adding a comment
To add a comment, click Add Comment at the top of theMessage Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
Basic text formatting of bold, italic, and underline can be used.

If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text. The
tag displays as @FirstName LastName.

When you click Post, the comment is saved to themessage stream, and any tagged users will be notified.
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NOTES:
l All users with access to the document can see comments posted to themessage stream. Any

comments made should be appropriate for the entire document audience. Do not post any
sensitive information to themessage stream.

l Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

� Ongoing notifications (subscriptions)
If you havemade a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task pane.

The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Exiting Axiom Strategy Management
To exit Axiom Strategy Management, in theMain ribbon tab, click the Close Axiom Software button in
the Exit group.

You can also simply close the application by clicking the X button in the top right corner of the window.
Axiom Strategy Management prompts you to save any changes to unsaved files.

About System Administration
System administration involves basic configuration and maintenance tasks, some that you perform only
once and some that you need to perform regularly. You perform most admin tasks from administrative
pages in theWeb Client, but a couple are performed in the Desktop Client, as noted in this section.

� Admin pages
System administrators perform most administration functions in the Admin pages.
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� Maintenance

Admin Maintenance page example

On theMaintenance page, you perform maintenance tasks on the elements that make up the strategy
hierarchy: Perspectives, Objectives, and Initiatives.

You also create new Perspectives and Objectives here. Initiatives are created elsewhere by users who
have the Initiative Creator role. However, you create and manage Opportunities and Resources from this
page, both of which are used in Initiatives.

This page also provides access to the following utilities:

Tab Utility Description

Process
Step

Initiative
Pending
Reset

Resets Initiatives back to the active tracking stage after the Initiative
sponsor approves the updates made by the Initiative owner for the
current period. Resetting Initiatives enables them to be updated during
the next current period.

Import Process
Plan Files

Integrates imported Initiatives into active tracking.
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Tab Utility Description

Data
Utilities

Update
Measure
Target
Status

Automatically updates theMeetsTarget column entries for all measure
data, based on theMeetsTargetDirection values set for each measure.

Update
Period
Measure
Data

Updates period measure data values, target values, and benchmark
values.

Create
Measure
Data

Automatically creates measure data rows with populated target fields for
hierarchy items when a newmeasure with a defined target is added to the
hierarchy item.

Delete
Aborted
Initiatives

Automatically removes all aborted Initiatives and their related data from
the Axiom Strategy Management system, including the Initiatives data
tables.

Delete
Orphan
Measure
Data

Automatically removes measure data left over from changing a hierarchy
measure’s time frame.

Update
Measure
Data
Actuals

Automatically updates hierarchy measure data from actuals imported to
the system. This utility runs daily but administrators can run it on demand
at any time.

Resolve
Exceptions

Helps administrators track and identify data exceptions that need to be
resolved when data imported to the system does not match up with data
in the system. Displays themismatched data in the ResolveMeasure Data
Exceptions form.
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� Settings

Admin Settings page example

On the Settings page, you can change the default system names for Perspectives, Objectives and
Initiatives; manage user preferences; and update the Current Period for the system.

� Measures
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Admin Measures page example

You maintain Perspectivemeasures, Objectivemeasures, and measures used by Initiatives from the
Measures page. Maintaining measures includes regularly updating measure data, and occasionally
adding, editing, enabling, disabling, or deleting measures. You can also assign drill documents to drills.

� Desktop Client Admin tasks
The following administrative tasks are currently only available from the Desktop Client or involve using
the Desktop Client.

l Initiatives – Import Initiatives in bulk
l Measures

o Add a benchmark to a measure
o Create a measure drill

l Security –Manage user roles
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Configuring Settings
Changing default system names is a task you should perform only once, when your system is
implemented or shortly thereafter.

Instructions for the following tasks apply to working in the Admin Settings page of theWeb Client.

l Change default system names – Use this setting to change the default names “Perspective,”
“Objective,” or “Initiative” if desired.

l Enable or disable the Initiative Overview tab – Use this setting to re-enable the Overview tab on
the Initiative plan file page for users who have disabled it and want it back.

l Update the current period – Use this setting to update the current month and year displayed at
the top right ofmost Axiom Strategy Management pages.

Change default system names
System Settings control default names for themain strategic entities in Axiom Strategy
Management: Perspective, Objective, and Initiative. You can change these to something else when your
system is initially set up and configured. For example, you could change “Perspective” to “Pillar.”

IMPORTANT: To avoid data integrity problems, do not change system names once they are being
used, and the named items have attached data in the system. You should reset names only once,
and at the time Axiom Strategy Management is first set up.

To change a default name:
1. In theNavigation panel, click Admin > Settings.

2. On the Settings page, click the System Settings tab if it is not already selected.

3. In the field for the name to change, delete the old name and then type the new one.

4. Click Save.

3
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Update the current period
Throughout Axiom Strategy Management, you and other users interact with the system during a span of
time referred to as the current period. The current period displays at the top right of themain Axiom
Strategy Management pages.

The system administrator updates the current period when it is time to roll to the next period. The
month used as the current period depends on your organization’s fiscal schedule.

IMPORTANT: Axiom Strategy Management uses measure data for the current period when
calculating performance. Be aware that using an open fiscal period may cause the performance of
some items to be inaccurately represented if measure data for those items has not been entered for
the current period. We recommend using themost recent completed, closed fiscal period, if possible,
so that the KPI icons accurately reflect the performance of your Perspectives, Objectives, and
Initiatives.

NOTE: Other Axiom software products may have their own defined current periods. As used here,
the current period applies to the Axiom Strategy Management system.

To update the Axiom Strategy Management current period:
1. Ensure that all measure data has been recorded and, if applicable, approved, for the period you

are rolling from.

2. In theNavigation panel, click Admin > Settings.

3. On the Settings page, click the System Settings tab if it is not already selected.

4. Below the default name settings, from the SM Current Period drop-down, select themonth and
year. You can also search for themonth and year by typing themonth in the Type to search field.
Add a comma after typing the name of themonth, to view available years.

5. Click Save.

Enable or disable the Initiative Overview tab
In Initiative plan files, the Overview tab is enabled by default. Initiative creators and other users who
have access to Initiative plan files in theWeb Client can disable the Overview tab that provides
instructions on creating Initiatives. If, however, a user wants to re-enable the tab, there is currently no
way for the user to do that in Initiatives plan files. As system administrator, you can re-enable the tab for
any user.

To enable or disable the Initiative Overview tab:
1. In theNavigation panel, click Admin > Settings.

2. On the Settings page, click theUser Preferences tab.
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When an Enable Overview tab setting is set to On, the user can see the Overview tab; when it is
set to Off, they cannot:

User Preferences tab showing which users have enabled/disabled the Initiative Overview tab

3. Click the Enabled toggle to On.

4. Click Save.

The next time the user visits the Initiatives page, the Overview tab will display. If it is not, ask the user to
refresh the page.
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Maintaining the strategy hierarchy
During initial setup of Axiom Strategy Management, your Kaufman Hall consultant adds default data and
sets up any existing Perspectives and Objectives. Your system will require some additional configuration,
and you will need to regularly perform maintenance tasks. See the following topics for information and
instructions.

l Maintaining Perspectives – Add, enable, disable, or change the active period for Perspectives.
l Maintaining Objectives – Add, enable, disable, or change the active period for Objectives.
l Maintaining Initiatives– Bulk import Initiatives, reset updated Initiatives to Active Tracking, and

maintain opportunities and resourcing used in creating Initiatives.
l Delete aborted Initiatives – Remove aborted Initiatives from the system, including from all related

data tables.
l For information on maintaining measures and related data, see About maintaining measures.

Maintaining Perspectives
Axiom Strategy Management comes with default Perspectives that you can either use as-is, edit to suit
your organization’s needs, or delete from the system. You can also add new Perspectives. After you set
up Perspectives, the only maintenance they require is enabling or disabling based on their Period Begin
and End dates. Measures applied to enabled Perspectives do require regular updating.

� Add a Perspective
Setting up a Perspective involves creating the Perspective and then adding at least onemeasure to it to
track its performance during its active period.

To add a new Perspective:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click the Perspectives tab if it is not already displayed.

3. On the left side of the page under theDescription column heading, click Add New Perspective.

4. In the Add New Perspective dialog, do the following:
a. In theDescription field, type a name for the Perspective.

4
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NOTE: This field has a 150-character limit.

b. To enable the Perspective, click the Enabled toggle to On.

NOTE: Disabled Perspectives cannot be selected for Objectives, nor will they display on
the Dashboard.

c. In the Begin Period drop-down, select the start date.

d. In the End Period drop-down, select the end date.

e. Click OK.

5. (Optional) Select an icon for the Perspective: In the Icon column for the new Perspective, type or
paste the code for the new icon. For instructions on how to get more icons, see Get Perspective
icons.

NOTE: You cannot change the color of Perspective icons.

6. Click Save.

7. Add a Perspectivemeasure.

8. Add an Objective.

� Edit or delete a Perspective
After Perspectives are set up, you probably will not need to edit them except to enable or disable them,
or change their active period.

Edit tasks can include:

l Activating a Perspective that is ready for use
l Disabling a Perspective that is no longer in use or that is not ready for use
l Changing Period Begin and End dates
l Changing the Perspective icon
l Changing the Perspective name
l Deleting a Perspective that was created in error or never used or is not being used by an Objective

To edit a Perspective:
1. In theNavigation panel, click Admin >Maintenance.

2. Click the Perspectives tab if it is not already displayed.

3. Do any of the following as needed:
l To activate a disabled Perspective, click the Enabled toggle to On.
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l To disable a Perspective, click the Enabled toggle to Off.
l To change the Period Begin and Period End dates, select the desired date from the drop-

down lists.

NOTE: Be aware of how any associated Perspectivemeasures are affected by a time
frame change, and edit those as well where needed.

l To change the icon, in the Icon column, type or paste the code for the new icon. For
instructions on how to obtain icon codes, see Get Perspective icons.

l To change the Perspective name, type the new name in theDescription field.

NOTE: A name change will be reflected everywhere the Perspective name is used in the
system, including historical reports. The exception is when the name appears in
snapshots.

l To delete a Perspective that was created in error or never used and has no attached data,
Objectives, or Initiatives, click the check box to the left of theDescription field. The
Perspective is deleted after you save your changes.

4. Click Save.

Maintaining Objectives
Like Perspectives, you can enable or disable Objectives and assign measures to them. Objectives are tied
to a period of activation during which themeasure associated with the Objective can collect data. Each
Objectivemust be associated with a single Perspective. Objectives usually have associated Initiatives,
although this is not required.

Admins manage Objectives from the Objective tab on the Admin Maintenance page. In addition to listing
all Objectives in the system, this tab also lists Objectives associated with a disabled Perspective.

Add an Objective
By default, all enabled Objectives display on the Dashboard.

To add a new Objective:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theObjective tab.

3. On the left side of the page under the Description column heading, click Add New Objective.

4. In the Add New Objective dialog, do the following:
a. In theDescription field, type a name for the Objective.
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NOTE: The Description field has a 150-character limit.

b. To enable the Objective, click the Enabled toggle to On.

NOTE: Disabled Objectives do not display on the Dashboard and cannot be associated
with Initiatives.

c. From the Perspective drop-down, select the Perspective to associate with this Objective.
This step is required before you can save the Objective.

d. In the Begin Period drop-down, select the start date.

e. In the End Period drop-down, select the end date.

f. If the Objective owner is someone other than yourself, then from theOwner drop-down,
select the desired user.

NOTE: By default, the person creating the objective is listed as the owner.

g. Click OK. Themeasure is added to the end of the Objectivemeasure list.

5. Add a measure to the Objective.

Edit or delete an Objective
Edit tasks can include:

l Activating an Objective that is ready for use
l Disabling an Objective that is no longer in use or that is not ready for use
l Changing the Objective name
l Changing the Period Begin and End dates
l Changing the Objective owner
l Changing the associated Perspective (not recommended)
l Deleting an Objective that was created in error or never used and has no associated data

To edit or delete an Objective:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theObjectives tab.

3. Do any of the following as needed:
l To activate a disabled Objective, click the Enabled toggle to On.
l To disable an Objective, click the Enabled toggle to Off.
l To change an Objective name, in theDescription field, type the new name.
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NOTE: A name change will be reflected everywhere the Objective name is used in the
system. This is useful if you discover a typo or if you want to distinguish the name from
another similarly-named Objective.

l To change the Period Begin and Period End dates, select the desired date from the drop-
down lists.

NOTE: Be aware of how any associated Objectivemeasure frequency periods are
affected by a time frame change, and edit those as well where needed.

l To change the associated Perspective, select the desired Perspective from the Perspective
drop-down.

IMPORTANT: If you change the Perspective to which an Objective is associated and
that Objective has accrued historical data, all the historical data will move to the new
Perspective.

l To change the Objective owner, in theOwner field, select a different user from the drop-
down.

l To delete an Objective that was created in error or never used and has no attached data or
Initiatives, click the check box to the left of theDescription field. The Objective is deleted
after you save your changes.

4. Click Save.

Maintaining Initiatives
As system administrator, you maintain some of the elements used in creating Initiatives as well as
resetting Initiatives to the active stage after their measure data has been updated and approved each
fiscal period. You may also need to import a file of Initiatives.

Maintenance tasks for Initiatives include:

l Maintaining opportunities used in creating Initiatives
l Maintaining resources used in creating Initiatives
l Resetting Initiatives to active tracking status
l Importing Initiatives in bulk
l Creating Initiatives from Capital Planning data
l Deleting aborted Initiatives
l Updating Initiativemeasure data – The Initiative owner typically updates Initiative data, but if you

ever need to, use these instructions.
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Maintaining opportunities
You can use opportunities as guides in the Initiative creation and approval process. Initiative creators are
prompted to answer the opportunity questions to show how the Initiative they are submitting aligns
with the Objective and Perspective (or other Initiatives), with which it is associated. When reviewing an
Initiative for approval, approvers can also read these questions and answers to help them evaluate the
Initiative. Currently, responding to opportunity questions is not mandatory for Initiative creators.

Add an opportunity

Keep opportunity questions broad enough to fit any Initiative because enabled opportunities are
available during the Initiative creation process for all Initiatives.

To add an opportunity:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theOpportunities tab.

3. On the left side of the page under the column headings, click Add Opportunity.

4. In the Add Opportunity dialog, do the following:
a. In theDescription field, type a question that you want an Initiative creator to consider

when creating an Initiative.

NOTE: The Description field has a 150-character limit. The number of characters used
displays to the right of the field. You can see howmany characters you have used by
clicking on a blank area outside the field.

b. To activate the opportunity, click the Enabled toggle to On.

c. Click OK.

5. Click Save.

Edit or delete an opportunity

Editing tasks can include:

l Changing the opportunity text
l Enabling an opportunity
l Disabling an opportunity so it does not display in Initiative plan files
l Deleting an opportunity that was created in error or never used

To edit or delete an opportunity:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theOpportunities tab.

3. Do any of the following as needed:
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l To activate a disabled opportunity, click the Enabled toggle to On.
l To disable an opportunity, click the Enabled toggle to Off.

NOTE: If you disable an opportunity, the opportunity no longer displays in the
Opportunities tab for any Initiative plan file.

l To change the text, in theDescription field, delete the text you do not want, and type the
new text.

IMPORTANT: Be aware that the text will change for this opportunity in all Initiative
records.

l To delete an opportunity, click the check box to the left of theDescription field. The
opportunity is deleted when you save your changes.

NOTE: You cannot delete an opportunity that is currently enabled or that is in use by a
record. If you cannot delete an opportunity, an error message displays with an
explanation.

4. Click Save.

Maintaining resourcing
Resourcing ensures that whenever an Initiative requires a certain resource, the need for that resource is
communicated to the right people so they can be sure it is available when needed. Enabled resources are
available for selection in all Initiatives.

Add a resource

To add a resource:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click the Resourcing tab.

3. On the left side of the page under the column headings, click Add Resource.

4. In the Add Resource dialog, type a name for the resource in the Resource field.

NOTE: The Resource field has a 150-character limit. The number of characters entered displays
to the right of the field after you save.

5. To activate the resource so Initiative creators can use it, click the Enabled toggle to On.

6. Click OK.

Edit or delete a resource

Edit tasks can include enabling, disabling, deleting, or changing the description of a resource.
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To edit or delete a resource:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click the Resourcing tab.

3. Do any of the following as needed:
l To activate a disabled resource, click the Enabled toggle to On.
l To disable a resource, click the Enabled toggle to Off.
l To change the description, replace the text in theDescription field.

NOTE: Changing the Description affects all the records in which the resource appears,
so unless the change is to correct a typo or improve the phrasing, do not re-purpose a
resource; instead, disable it and create a new one.

l To delete a resource, click the check box to the left of theDescription field. When you save
changes on this page, the resource is deleted.

NOTE: Do not delete a resource that is currently in use by an Initiative or that is
attached to historical data. It is better to retire (disable) the resource instead.

4. Click Save.

Reset Initiatives to active tracking
The Initiative update review process requires the system administrator to reset Initiatives back to the
active tracking stage after the Initiative sponsor approves the updates made by the Initiative owner for
the current period. Resetting Initiatives enables them to be updated during the next current period.

To reset Initiatives to active tracking status:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click the Process Step tab.

3. In the Initiative Pending Reset section on the right, review the listed Initiatives to be sure they are
all ready to be reset.

4. If an Initiative does not belong in the list:
a. In theNavigation panel, click Initiatives.

b. On the Initiatives page, click the bookmark icon ( ) to the left of the Initiative.

c. On the Initiative routing page, click Reject to reject the current step (Step 7) and send the
Initiative back to the previous step.

d. On the Process Step tab of theMaintenance page, in the Initiative Pending Reset section,
click the refresh button and verify that the Initiative that did not belong is not in the list.

5. Click Submit.
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6. Click Save.

Import Initiatives in bulk
Axiom Strategy Management can contain as many Initiatives as your organization needs. Since there is
the potential to have hundreds of Initiatives, we provided a means for system administrators to import
Initiatives in bulk. You can manually enter Initiative information to the system, where the Initiatives can
be processed into the system for immediate use.

To import Initiatives in bulk:
1. Review the requirements in the following Requirements table.

2. Launch the Desktop Client.

3. If the Explorer task pain is not open, in theMain tab of the ribbon, click Navigation, and select
Explorer.

4. In the In the Libraries section of the Explorer task pain, expand the Table Library and then expand
!Dimensions.

5. Scroll down to and double-click Initiative.

6. In theOpen Table in Spreadsheet dialog, click OK.

7. In the Initiative spreadsheet, scroll down to the first blank row. Add information starting with the
Description column.

NOTE: Do not add a number in the first column; the system will add the number after you
save the spreadsheet.

8. In theMain ribbon tab, click Save.

9. In theWeb Client Navigation panel, click Admin >Maintenance.

10. On theMaintenance page, click the Import tab.

11. Click the Process Plan Files button to integrate the imported Initiatives into active tracking.

Requirements
Before you begin, you need the following information for each Initiative. The fields are either required or
need to contain information to avoid data displaying incorrectly in some forms.

Data field Format Description Lookup location

Description Text Initiative name NA

LongDesc Text Detailed description of
Initiative

NA
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Data field Format Description Lookup location

Objective Number Objective to which the
Initiative belongs

Table Library>
Dimensions>
Objective

Department Number Department the Initiative
applies to, if applicable;
otherwise, enter “0” for None

Table Library >
Dimensions > DEPT

Owner Username User who owns the Initiative Security Manager

Sponsor Username User who sponsors the
Initiative

Security Manager

Status Number Enter 0 because at this point,
themilestones do not have
status yet.

Table Library >
Strategy
Management > Data
> Status

Workstream Number Workstream for Initiative, if
applicable; otherwise, enter
“0” for None

Table Library >
Strategy
Management > Data
>Workstream

PhysicianImpact TRUE/FALSE If the Initiative impacts
physicians, enter “TRUE”, if
not, enter “FALSE”

NA

Category Number Select a category for the
Initiative; otherwise, enter
”0” for None

Table Library >
Strategy
Management > Data
> InitiativeCategory

CapitalInvolved TRUE/FALSE If the Initiative requires
capital, enter “TRUE’, if not,
enter “FALSE”

NA

ApprovalDate Date &
Time

M/dd/yyyy

0:00
AM/PM

Date the Initiative was
approved for Active Tracking
for first time

IMPORTANT: If you do not
enter an approval date, the
Initiative status will not be
correctly represented in the
plan file after import.

NA
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Data field Format Description Lookup location

ApprovedBy Username User who approved the
Initiative to Active Tracking
for first time

Security Manager

Active TRUE/FALSE Whether the Initiative is
currently active

NA

Archived TRUE/FALSE Whether the Initiative is
currently archived

NA

InitiativeTemplate Text Template used to build the
Initiative; SM Main if created
in Axiom Strategy
Management

File Groups >
Strategy
Management –
Requests\Templates

InitiativeShowOnColumn TRUE/FALSE Enter “TRUE” to ensure a
plan file is created for the
Initiative when the
administrator uses the
Import utility.

NA

InitiativeRequestor Username User who created the
Initiative

IMPORTANT: Do not leave
the InitiativeRequestor field
blank because this could
cause unintended data
issues.

Security Manager

InitiativeRequestComment text Comment added by
requestor in Comment field
of Generate a New Initiative
Request form

Optional

InitiativeSource SM (or
other)

Indicates Axiom product in
which Initiative request
originated. Enter “SM” for
Strategy Management;
otherwise, enter code for
other integrated product,
such as Comparative
Analytics (CompA)

NA
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Create Initiatives from Axiom Capital Planning data
Axiom Strategy Management administrators can create Initiatives from imported Axiom Capital Planning
data for Axiom Strategy Management systems integrated with Axiom Capital Planning.

The Axiom Capital Planning integration utility on the Admin Maintenance page steps you through the
process of creating Initiatives from imported Axiom Capital Planning data.

You need the following to use this utility:

l An Axiom Strategy Management system integrated with Axiom Capital Planning, with active
licenses for both

NOTE: Currently, integration is supported only in theWeb Client.

l SM Admin role and the Initiative Creator role
l Any Axiom Capital Planning role

NOTE: The individual CapReqs that are visible to you depend on existing Axiom Capital Planning
security.

To create Initiatives from Axiom Capital Planning projects:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click the Integration tab.

3. On the Integration tab, click the Capital Planning utility button.

4. From the Select Source File Group drop-down, select the desired Capital Planning year, and then
click Next.
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5. From the File Group list, select the desired Capital Requisition, and then click Submit.

IMPORTANT: You need to have YRMO records for all of the OrigBudget years in which your
projects run.

Notice that there is a Project Target column. The system uses the amount in this column as the
new Initiative’s Target.

Administrator's Guide Axiom Strategy Management │ 60



6. In theGenerate a New Initiative Request dialog, enter all required information. Note that you
must select a Frequency. Click Create Initiative. (For details, see “Create an Initiative” in the online
help.)

7. In the new Initiative’s plan file:
a. Complete the needed information in the rest of the tabs. For details, see “Create an

Initiative” in the online help.

b. In theMilestone/Measures tab, add any desired milestones.

c. For the new Initiativemeasure, be sure to add a Baseline. You can rename the Initiative
measure if desired. TheMeasure’s Start and End dates are based on the years in which the
CapReq runs.

d. To submit the Initiative for review and approval, click Submit.

Delete aborted Initiatives
Strategy Management system administrators can purge aborted Initiatives from the system using the
Delete Aborted Initiatives data utility.

Axiom Strategy Management is designed to house hundreds of Initiatives. Once an Initiative is submitted
for Owner approval, it begins to accrue a historical record. Each time an Initiativemoves to another stage
in the approval process, reviewers and approvers can add comments that also become a part of the
historical record. Initiatives and their related data are stored in several data tables in the system.
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Some Initiatives get aborted because they are not needed, are duplicates, were created in error, etc.
Initiatives can be aborted at two steps in the Creation Approval process: Step 4 – Committee Approval,
and Step 5 – Active Tracking. Initiatives must be terminated using the abort process at one of these steps
in order to be deleted using the Delete Aborted Initiatives data utility.

NOTE: Initiatives that have been denied should not be confused with aborted Initiatives, or
completed Initiatives.

To delete aborted Initiatives from the system:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theData Utilities tab.

3. Click theDelete Aborted Initiatives button.

4. In the Select aborted Initiative plan file(s) to be deleted dialog, do one of the following:
l For each Initiative to delete, select the check box to the left of the ID number.
l To delete all listed Initiatives, select the check box in the header row.

5. Click Yes.

A small confirmation message displays at the bottom of the page:

The utility removes the selected aborted Initiatives and any related data from the following tables:

l Initiative table
l InitiativeMilestoneData
l InitiativeMeasureData
l InitiativeMilestone
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l InitiativeMeasure
l InitiativeResource
l InitiativeOpportunity
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Maintaining measures
Perspectives, Objectives, and Initiatives have associated measures that require initial set up and some
maintenance. Axiom Strategy Management comes with some built-in measures, including default
measure types and classes. For more information, see About measures.

About the Measures page
TheMeasures page contains a library ofmeasures available for use in Perspectives, Objectives, and
Initiatives. You perform measuremaintenance tasks from theMeasures page, accessed from the Admin
menu in the Navigation panel. The exception is uploading measures in bulk, currently performed in the
Desktop Client.

Measures tab –Master list of all measures currently in the system. Perspectives, Objectives, and
Initiatives get their measures from this list. Information entered in this tab is stored in theMeasure table,
accessible from the Desktop Client, and located in the Table Library under Dimensions >Measure. The
measures list contains hundreds ofmeasures, but you can filter the list.

Type tab – Lists all themeasure types available to use in measures. Information entered in this tab is
stored in theMeasureType table, located in the Table Library under Strategy Management >Data.

Class tab – Lists all themeasure classes currently in the system. Axiom Strategy Management comes
preloaded with a number ofmeasure classes commonly used in the healthcare industry. For example, we
have included frequently-used groups as defined by the U.S. Centers for Medicare &Medicaid Services
(CMS) and by the Hospital Consumer Assessment of Healthcare Providers (HCAHPS). This information is
stored in the Class table located in the Table Library under Strategy Management > Class.

Perspective Measure – Lists all Perspectives and themeasures associated with each, including Period
Begin and Period End dates, Baseline, Target, Department (optional), and Entity (optional).

Objective Measure – Lists all Objectives and their associated measures, including Period Begin and
Period End dates, Baseline, Target, Department (optional), and Entity (optional).

Drill Documents – Lists drill-down documents available for linking to measures, and provides function for
adding new drill documents. These documents typically contain details on the associated measure data,
and can provide supporting information and additional details about where and how themeasure data
was derived.

Update Measure Data – Launches theMeasure Update web input form used for updating measure data.

5
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Measure maintenance tasks
By default, measures are set to require maintenance on a monthly/current period basis.

Click the following links for instructions on each task:

l Find a measure in the list (filtering measures)
l Add a measure
l Edit a measure or delete an unused measure
l Maintain measure types
l Maintain measure classes
l Updatemeasure data
l Maintain Perspectivemeasures
l Maintain Objectivemeasures
l Createmeasure data rows
l Delete orphaned measure data
l Updatemeasure target status
l Update period measure data
l Add a benchmark to a measure
l Managing measure drills
l Create a measure drill
l Edit or delete a measure drill

Filter the Measures list
Axiom Strategy Management can contain hundreds ofmeasures listed under theMeasures tab on the
Measures page. You can filter the list to find themeasure you want.

NOTE: These instructions assume you are already on theMeasures tab of the Admin Measures page.

To filter the Measures list:
1. From the Class Filter drop-down, select one of the following:

l If you know the class themeasure belongs to, select the class.
l If you do not know the class themeasure belongs to, select All.

2. Do one of the following:

l To search for enabled measures only, verify that the Filter Disabled toggle is set to On.
l To search for enabled and disabled measures, click the Filter Disabled toggle to Off.

3. In the Search field, click near themiddle to activate it, and then type a word or two to search on,
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and press Enter.

The search returns all measures that match your search terms.

NOTE: If a measure name is too long to be displayed in full, hover your cursor over the name
to see the full name in a tool tip.

4. To clear the search field for a new search, click the small x icon to the right of the Search field, and
repeat steps 1 through 3.

Add ameasure
System administrators can add measures to themain measures list.

To add a measure to the main Measures list:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click theMeasures tab if it is not already selected.

3. On the left under theDescription column heading, click Add New Measure.

4. In the Add New Measure dialog, do the following:
a. In theDescription field, type a name for themeasure. This field has a 150-character limit.

b. From the Precision drop-down, select the number of data places to include after the
decimal when measure data is displayed in Measure Details windows:

l 0 – No digits display after the decimal
l 1 – One digit displays after the decimal
l 2 - Two digits display after the decimal (default setting)

c. To enable themeasure after saving it, click the Active check box.

d. From the Class drop-down, select a class for themeasure.

e. From theGL Acct drop-down, select an account with which to associate this measure.

f. From the Favorable drop-down, select theMeetsTargetDirection for themeasure.

g. From theUnit drop-down, select the type of unit that matches the data that themeasure
collects:

l Number – Select for numeric measure data.
l Amount – Select for currencies.
l Percent – Select for percentages.

h. From the Type drop-down, select the updatemethod used to derive themeasure:

l Calculated – Axiom software automatically calculates themeasure data whenever a

Administrator's Guide Axiom Strategy Management │ 66



query is made to the field.

l Integrated – Themeasure data comes from integrated Kaufman Hall Axiom
products.

l Input – Themeasure data is entered directly into Axiom Strategy Management from
an external source. This data may come from a form with data entered manually or
from input utilities.

NOTE: Currently, the Type field is for recording a description of themethod used; it
does not set any action for themeasure.

i. From the Frequency drop-down, select how often themeasure is updated and reported.

IMPORTANT: Once you set a frequency for a measure and save it, you cannot change
the frequency. If themeasure is unused and has accumulated no data, you can delete it
and start over. Otherwise, retire themeasure by disabling it, and then create a new
one.

j. (Optional) In the Formula Description field, type a description of how the data is derived.
For example, if themeasure is “Hours paid per patient day” then the formula would be
something like “Hours paid divided by Inpatient days” or “Hours paid / Inpatient days.”

l To associate this measure with a drill document, select the desired drill document
from theUser Drill drop-down.

l To not associate this measure with a drill document, select 0 - No Selection from the
User Drill drop-down.

NOTE: Measures that have associated drill documents display a Launch Detail button in
their Measure Detail window.

5. Click OK.

6. Click Save.

Edit or delete a measure
The system administrator can edit and deletemeasures but there are some caveats. After a measure is in
use by a Perspective, Objective, or an Initiative, you should not need to edit it unless there is something
wrong with the description, formula description, or other attribute that you need to change so that the
measure works correctly. You cannot change a measure’s frequency. If themeasure is unused and has
accumulated no data, you can delete it and start over. Otherwise, retire themeasure by disabling it, and
then create a new one.

Editing a measure can include:
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l Changing the Description
l Enabling or disabling themeasure
l Changing the Class
l Changing the GL Account
l Changing the Type (not recommended)
l Changing the Formula Description
l Adding or changing a User Drill
l Changing the decimal display precision
l Deleting themeasure

To edit or delete a measure:
1. In theNavigation panel, click Admin >Measures.

2. In theMeasures tab on theMeasures page, locate themeasure. Filter the list if needed.

3. Do any of the following, as needed:
l To enable themeasure, click the Enabled toggle to On.
l To disable themeasure, click the Enabled toggle to Off.
l To edit themeasure name, in theDescription field, type the new name or make corrections

to the existing name.

IMPORTANT: If you change a measure’s name (description), this also changes the
name in any historical records that have not been saved in static reports.

l To change the associated GL Account, from theGL Account drop-down, select another
account, or, to remove the affiliation with an account, click 0-Default ACCT. The field will
revert to the default text “Type to Search” after you save your changes.

l To change the class, from the Class drop-down, select the new class.

IMPORTANT: If you change a measure’s class, this also changes the class in any
historical records that have not been saved in static reports.

l To change the type, from the Type drop-down, select the new type.

IMPORTANT: If you change a measure’s type, this also changes the type in any
historical records that have not been saved in static reports.

l To change the formula description, in the Formula Description field, type the desired
information.

l To add a user drill for themeasure, in theUser Drill column, select the desired drill from the
User Drill drop-down.

l To change the number of values displayed after the decimal, from the Precision drop-down
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select the desired number.
l To delete a measure:

a. Verify that themeasure is not in use and has no data records attached.
b. Select the check box at the left end of themeasure row. Themeasure will be deleted

after you save changes.

4. Click Save.

Maintaining measure types
Measure types are themethodologies used to update and report measure data. Currently, the Type field
is for recording a description of themethod used; it does not set any action for themeasure.

Axiom Strategy Management comes with threemeasure types:

l Calculated –Measure data is calculated automatically by Axiom software whenever a query is
made to the field.

l Input –Measure data is entered directly into the system from an external source. You may input
data manually using forms or enter data in bulk using import utilities.

l Integrated –Measure data comes from integrated Kaufman Hall/Axiom products.

Measure types you add or edit from the Admin Measures page are stored in theMeasureType data
table.

Add a measure type
You can create additional measure types, if needed.

To add a measure type:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Type tab.

3. Under theDescription column, click Add New Type.

4. In the Add New Type dialog, type a description in theDescription field. This field has a 150-
character limit.

5. To enable this type after saving, click the Active check box.

6. Click OK. The new type is added to the list of types.

7. Click Save.

Edit or delete a measure type
You can change the name and status of a measure type.
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IMPORTANT: Do not deletemeasure types that are used in other data tables because this could
cause orphaned data and lead to data integrity errors. Instead, it is better to disable the type so it
does not display in the Type selection drop-down. However, if you add a type and decide not to use
it, you can delete it as long as it has no attached data.

To edit or delete a measure type:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Type tab.

3. For the type to edit, do any of the following as needed:
l To enable a disabled type, click the Enabled toggle to On.
l To disable a type, click the Enabled toggle to Off.
l To change the name, edit the text in theDescription field.
l To delete a type that is not in use in any data table, click the check box to the left of the

Description field. The type is deleted when you click Save.

4. Click Save.

Maintaining measure classes
Measure classes allow you to categorizemeasures that have one or more common attributes so that
you can organize and manage them, and filter them in lists, reports, and Initiative plan files. A number of
default measure classes are included in Axiom Strategy Management. These were selected from
frequently-used groups defined by the U.S. Centers for Medicare &Medicaid Services (CMS), by the
Hospital Consumer Assessment of Healthcare Providers (HCAHPS), and from a large set of standard
financial metrics. You can use any of these, disable or delete the ones you do not want, and add your
own classes.

Measure classes you access from the Admin Measures page are stored in the Class reference table.

Add a measure class
To add a measure class:

1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Class tab.

3. Under theDescription column, click Add New Class.

4. In the Add New Class dialog, type a name in theDescription field. This field has a 150-character
limit.

5. To enable this class after saving, click the Active check box.
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6. Click OK.

7. Click Save.

Edit or delete a measure class
You can enable and disable a measure class, change its name, or delete it. However, you should not
change the number assigned to the class by the system because the system uses these numbers in
reports.

IMPORTANT: Do not deletemeasure classes that are used in other data tables because this could
cause orphaned data and lead to data integrity errors. Instead, it is better to disable the class so it
does not display in the Class selection drop-down. However, if you add a class and decide not to use
it, or to remove any of the default classes that camewith Axiom Strategy Management, you can
delete them as long as they have no related data in other data tables. The exceptions to this are the
performance improvement measure classes, which should not be deleted or renamed.

To edit or delete a measure class:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Class tab.

3. For the class to edit, do any of the following:
l To disable a class, click the Enabled toggle to Off.
l To enable a class, click the Enabled toggle to On.
l To correct an error in the class name, make the change in theDescription field.

IMPORTANT: Be aware that changing the class namewill change the name in all
historical records that have not been saved as static records and archived somewhere.

l To delete a class that has never been used and is not attached to any data, click the check
box to the left of theDescription field. The class is deleted when you click Save.

4. Click Save.

Maintaining Perspective measures
Perspectivemeasures aremeasures applied from themain measure list to Perspectives. Although the
system allows you to create Perspectives without applying measures, you cannot track Perspective
performance unless you do. After creating a Perspective, the next step is assigning it one or more
measures. Themeasures you assign depend on how your organization defines the Perspective and
which of its aspects you want to track.
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Perspectivemeasures you add or edit from the Admin Measures page are stored in the Axiom Strategy
Management data table PerspectiveMeasure.

Add a measure to a Perspective
Generally, Perspectivemeasures should be broader than those used for Objectives and Initiatives
because Perspectives are at the highest level in the strategy hierarchy. The further down the hierarchy
you go, themore specific themeasures can be. For example, if your organization is a hospital and you
have a Perspective named Clinical Performance, you would want to assign a measure that returns broad
measure data, such as the Composite HCAHPS-Overall Hospital Rating.

To add a measure to a Perspective:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Perspective Measure tab.

3. Locate the Perspective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under themain tabs so you can
see only the Perspective names.

4. If the Perspective is collapsed, click the down arrow to the left of its name.

5. On the left under theMeasure column, click Add New Measure.

6. In the Add New Measure dialog, do the following:
a. From theMeasure drop-down, select the desired measure.

b. If you are tracking this measure at the department level, then from theDept drop-down,
select the department.

c. If you are tracking this measure at the entity level (such as a clinic, hospital location,
medical group, etc.), or if you selected a department in the previous step, from the Entity
drop-down, select the entity.

d. In the Period Begin drop-down, select themonth and year for themeasure to be active.

e. In the Period End drop-down, select themonth and year for themeasure to be inactive.

f. In the Baseline field, enter the baseline number to use as the data measurement starting
point.

g. In the Target field, enter the target number to use for comparing with data generated by
themeasure.
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NOTE: When setting the Target, be sure you knowwhich direction from the target
(higher or lower) is favorable and which is unfavorable for themeasure. You can look
this up in theMeasure table: launch the Desktop Client, open the Explorer task pane,
then expand Libraries > Table Library > !Dimensions >Measure. Locate themeasure in
the table and then scroll horizontally to the last column, MeetsTargetDirection.

h. Click OK.

7. Click Save.

8. Run the following utilities in this order:

l CreateMeasure Data to create themeasure data rows for each period in themeasure’s
lifecycle.

l Update Period Measure Data
l UpdateMeasure Target Status

IMPORTANT: To avoid data errors, run the utilities. The order is important:
1. CreateMeasure Data
2. Update Period Measure Data
3. UpdateMeasure Target Status
(The utilities are not listed in the correct execution order on the Admin Maintenance page.)

Edit or delete a Perspective measure
You can change the period dates, baseline, and target data for a Perspectivemeasure. You cannot delete
a Perspectivemeasure if it is in use or has data attached. If you want to disable a Perspectivemeasure,
you must disable it in theMeasures tab.

To edit or delete a Perspective measure:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click the Perspective Measure tab.

3. Locate the Perspective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under themain tabs so you can
see only the Perspective names.

4. If the Perspective is collapsed, click the down arrow to the left of its name.

5. For the desired Perspectivemeasure, do any of the following as needed:
l To change the Period Begin date, click the Period Begin drop-down, and select the desired

date.
l To change the Period End date, click the Period End drop-down, and select the desired
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date.

NOTE: If you shorten themeasure’s time frame, after saving your changes, run the
Delete Orphan Measure Data utility to remove target data associated with unused
future time periods.

l To change the Baseline number, click in the Baseline field, and change the number.

l To change the Target number, click in the Target field, and change the number.

IMPORTANT: The changemay be reflected everywhere the Perspectivemeasure is
used, including any historical records that have not been preserved as static reports.

NOTE: Currently, when you change the target number, you must manually update the
target in any data rows for future periods in themeasure’s active period. The Create
Measure Data utility does not update existing rows.

l To delete the Perspectivemeasure:
a. Verify that it can be deleted: if there is a check box to the left of the Perspective

measure name, it can be deleted. If there is a circle with a slash through it (X)
instead of the check box, you cannot delete the Perspectivemeasure.

b. Select the check box to the left of themeasure name. Themeasure is deleted when
you save changes.

6. Click Save.

Maintaining Objective measures
Objectivemeasures aremeasures applied from themain measure library to an Objective so that you can
track the performance of the Objective. You can apply as many measures as you like but the number
used depends on how you define the Objective and which of its aspects you want to measure. For
example, for an Objective named “Improve Patient Access,” you could add a measure that assesses the
average time it takes a patient to get scheduled for a primary care visit.

Objectivemeasures you add or edit from the Admin Measures page are stored in the Strategy
Management data table ObjectiveMeasure.

Add a measure to an Objective
Measures applied to Objectives should bemore specific than measures applied to Perspectives.

To add a measure to an Objective:
1. In theNavigation panel, click Admin >Measures.
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2. On theMeasures page, click theObjective Measure tab.

3. Locate the Objective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under themain tabs so you can
see only the Objective names.

4. If the Objective is collapsed, click the down arrow to the left of its name.

5. On the left under theMeasure column, click Add New Measure.

6. In the Add New Measure dialog, do the following:
a. From theMeasure drop-down, select the desired measure.

b. If you are tracking this measure at the department level, then from theDept drop-down,
select the department.

c. If you are tracking this measure at the entity level (such as a clinic, hospital location,
medical group, etc.), or if you selected a department in the previous step, then from the
Entity drop-down, select the entity.

d. In the Period Begin drop-down, select themonth and year for themeasure to be active.

e. In the Period End drop-down, select themonth and year for themeasure to be inactive.

f. In the Baseline field, enter the baseline number to use as the data measurement starting
point.

g. In the Target field, enter the target number to use for comparing with data generated by
themeasure.

NOTE: When setting the Target, be sure you knowwhich direction from the target
(higher or lower) is favorable and which is unfavorable for themeasure. You can look
this up in theMeasure table: launch the Desktop Client, open the Explorer task pane,
then expand Libraries > Table Library > !Dimensions >Measure. Locate themeasure in
the table and then scroll horizontally to the last column, MeetsTargetDirection.

h. Click OK.

7. Click Save.

8. Run the following utilities in this order:

l CreateMeasure Data to create themeasure data rows for each period in themeasure’s
lifecycle.

l Update Period Measure Data
l UpdateMeasure Target Status
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IMPORTANT: To avoid data errors, run the utilities. The order is important:
1. CreateMeasure Data
2. Update Period Measure Data
3. UpdateMeasure Target Status
(The utilities are not listed in the correct execution order on the Admin Maintenance page.)

Edit or delete an Objective measure
You can change the period dates, baseline, and target data for an Objectivemeasure. You cannot delete
an Objectivemeasure if it is in use or has data attached. You also cannot enable or disable an Objective
measure.

To edit or delete an Objective measure:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click theObjective Measure tab.

3. Locate the Objective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under themain tabs so you can
see only the Objective names.

4. If the Objective is collapsed, click the down arrow to the left of its name.

5. For the desired Objectivemeasure, do any of the following as needed:
l To change the Period Begin date, click the Period Begin drop-down, and select the desired

date.

l To change the Period End date, click the Period End drop-down, and select the desired
date.

NOTE: If you shorten themeasure’s time frame, after saving your changes, run the
Delete Orphan Measure Data utility to remove target data associated with unused
future time periods.

l To change the Baseline number, click in the Baseline field, and change the number.

l To change the Target number, click in the Target field, and change the number.

IMPORTANT: The changemay be reflected everywhere the Objectivemeasure is used,
including any historical records that have not been preserved as static reports.
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NOTE: Currently, when you change the target number, you must manually update the
target in any data rows for future periods in themeasure’s active period. The Create
Measure Data utility does not update existing rows.

l To delete the Objectivemeasure,
a. Verify that it can be deleted: if there is a check box to the left of the Objective

measure name, it can be deleted. If there is a circle with a slash through it (X)
instead of the check box, you cannot delete the Objectivemeasure.

b. Select the check box to the left of themeasure name. Themeasure is deleted when
you save changes.

6. Click Save.

Add a benchmark to a measure
Axiom Strategy Management provides you the ability to add external benchmarks to Perspective,
Objective, and Initiativemeasure data, to help you evaluate howwell these items are performing relative
to established bench-marked results from similar processes in other medical organizations that are like
yours.

System administrators can add benchmarks to Perspectivemeasures, Objectivemeasures, and Initiative
measures. Benchmarks are used and displayed in Measure Detail windows, such as in the following
example.

Administrator's Guide Axiom Strategy Management │ 77



Measure Detail example showing monthly benchmark line (green dotted) with point marker displayed where cursor is hovered
over line

NOTE: This task is performed in themeasure data tables from the Desktop Client.

To add a benchmark:
1. Launch the Desktop Client.

2. In theMain tab of the Ribbon, click Navigation > Explorer.

3. In the Libraries section, expand Table Library, then scroll down to and expand Strategy
Management >Data.

4. Double-click the desired MeasureData table (e.g., PerspectiveMeasureData,
ObjectiveMeasureData, InitiativeMeasureData).

5. In theOpen Table in Spreadsheet dialog, click OK.

6. In themeasure data table, locate the desired measure (listed by number, not name) and then
scroll to the Benchmark column titled Client-selected Benchmark value by month.
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7. For each month that you want to provide a benchmark, enter the number in the column for that
month.

8. In the Ribbon’sMain tab, click Save.

9. In the Save to database completed successfully confirmation dialog, click OK.

Managing measure drills
Axiom Strategy Management provides users the ability to drill down on a measure and see supporting
documentation by clicking a link in themeasure’s Measure Detail window. Supporting documentation
can be anything from a report showing where themeasure was derived or calculated, to a form or
spreadsheet with additional information.

As a system administrator, you can control and customize the reports and other documents that users
can drill to from a given measure. When you add a drill to a measure, the system adds a Launch Detail
button in the upper right corner of theMeasure Drill window. Clicking the button launches the drill
document. Drill documents must be stored in the Drill folder accessible from the Desktop Client at
Libraries > Reports Library > Strategy Management Utilities >Drill. If the document is an Axiom web-
enabled report or form, it opens in the browser. If the document is another type of file, such as a PDF or
Excel spreadsheet, the system opens it from the Desktop Client in a separate window.

Create a measure drill
Use these instructions to add a document drill to a measure to create a drill down in themeasure’s
associated Measure Detail window. Creating a measure drill involves threemain steps: 1) add the drill
document to Strategy Management, 2) create a drill for the document, and 3) associate the drill with the
desired measure.

Administrator's Guide Axiom Strategy Management │ 79



To create a new document drill:
1. In the Desktop Client, place the drill document in the Drill folder:

a. Navigate to Libraries > Reports Library > Strategy Management Utilities >Drill.

b. Right-click theDrill folder and select Import Files.

c. Select the desired file and click Open.

2. Expand theDrill folder, right-click the file and select Copy document path to clipboard. You will
need to paste this path into the Add Drill Document dialog in step 6c.

3. In theWeb Client, in theNavigation panel, click Admin >Measures.

4. On theMeasures page, click theDrill Documents tab.

5. On the left under theDescription column heading, click Add New Drill.

6. In the Add New Drill dialog, do the following:
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a. In theDescription field, type a name for this drill.

b. To enable this drill immediately after creation, select the Active check box.

c. In theDrill Filepath field, paste the file path you copied in step 2.

(To see how users access a drill document, see “Drill on measure details” in the online help.)

d. If the drill document is an Axiom report or form, click theWeb Enabled check box to enable
the form to open in the browser.

NOTE: Do not select the check box if the document is another type of file, such as a PDF
or Excel spreadsheet. The system opens these types of files from the Desktop Client in
separate window.

e. Click OK.

7. Click Save.

8. Next, assign this drill to the desired measure. Do one of the following:
l If themeasure does not currently exist, follow the instructions in Add a measure.
l If themeasure exists, navigate to the Admin - Measures page. In theMeasures tab, locate

themeasure. In theUser Drill column for themeasure, select the desired drill from the
drop-down. Click Save.

IMPORTANT: The drill document will be accessible for all hierarchy items that use the
associated measure, so be sure that the document applies to all instances in which the
measure is used or could be used. Alternatively, you can create a copy of themeasure
and give it a specific name and then associate the drill only to that version.

Edit or delete a measure drill
The system administrator can edit and deletemeasure drills; however, a measure drill cannot be deleted
if it is associated with a measure.

You can edit the following for a measure drill:

Administrator's Guide Axiom Strategy Management │ 81



l Change the drill name
l Enable or disable the drill
l Delete the drill if it is not in use

NOTE: You cannot change the document associated with a drill. Instead, create a new drill for the
new document, then remove the old drill from any measures, and then delete the old drill. Assign the
new drill to themeasure(s).

To edit or delete a measure drill:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, click theDrill Documents tab.

3. Do any of the following, as needed:
l To change the name, type changes in theDescription field.
l To enable / disable a drill, in the Enabled column, click the toggle to the desired state.
l To delete a drill:

a. Verify that it is not in use. If the drill is in use, remove it from all associated measures.
b. Click the checkbox to the left of the drill name. The drill will be deleted when you save

your changes.

4. Click Save.

Update measure data
TheMeasure Update page enables you to update data for one or more Perspective, Objective, or
Initiativemeasures, in a convenient web form.
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Measure Update page example

To update measure data:
1. In theNavigation panel, click Admin >Measures.

2. On theMeasures page, in the header, click theUpdate Measure Data button.

TheMeasure Update page opens.

3. Open the Filters panel: in the header menu above the navigation panel, click the Filters icon.

4. In theMeasure Filters section, from the Select Measure data to update drop-down, select the
type ofmeasure to update.

The type ofmeasure you select here determines the options available in the next drop-down. For
example, if you select Perspective, the next drop-down will contain a list of Perspectives.

5. To update a measure for a specific Perspective, Objective, or Initiative, in the Select a [item] drop-
down, select the desired item. Otherwise, leave this field blank to update all measures for that
item type.

6. If themeasure is associated with a specific entity or a department within an entity, in the
Department Filters section, select the entity and then the department from the corresponding
drop-downs.

7. In the Period Filters section, select one of the following as applicable:
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l All available periods – Returns all records for all periods that have that kind of data. For
example, if you are updating Objectivemeasure data, the system returns all Objective
measure records.

l Current Period – Returns all records that have that kind of data for the current period.
l Individual period – Select the desired period from the drop-down.

8. Click Apply.

The filtered measures display in theMeasure Update page.

TIP: To see the detail for a measure, click the graph icon ( ) to the left of themeasure name
at the top of theMeasure column. If themeasure has multiple entity or department
combinations, a pop-up dialog prompts you to select the entity/department to view.
For information on viewing related drill data (if applicable), see ”Drill on measure details” in the
online help.

9. To update a measure, click the Results field and type the value, then press Enter.

10. When finished updating values, click Save.

11. In the Axiom Software prompt, click OK.

12. To ensure that the posted values update for reports that use period measure data (such as the
Cost Reduction Status report), run the following utilities in the following order:

l Createmeasure data rows
l Update period measure summary data
l Updatemeasure target status

Create measure data rows
The CreateMeasure Data utility allows system administrators to automatically createmeasure data rows
for hierarchy items.

� About the Create Measure Data utility
Users need to be able to viewmeasure data targets in charts and reports for comparison and analysis
purposes, for each time period (frequency) set for a measure.

System administrators need to be able to set measure targets to respond to changing expectations.

To make this possible, the target needs to be set in each hierarchy item’s MeasureData table (i.e.,
PerspectiveMeasureData, ObjectiveMeasureData, InitiativeMeasureData) for each frequency period that
the hierarchy item measure is active. This means the Target field needs to be populated for future time
periods (months/quarters/half-years/years) according to themeasure’s frequency.

Administrator's Guide Axiom Strategy Management │ 84



Instead ofmanually creating new rows for future frequency periods in the hierarchy item’s active period
and then entering the target data, the CreateMeasure Data utility automatically creates a rowwith the
set target for each frequency period through the end of the fiscal year for the length of themeasure’s
active period (start date to end date).

For example, if an Objectivemeasure starts on January 2018 and ends on December 2019, the utility
creates rows in the ObjectiveMeasureData table with the target column pre-populated for all YRMOs
from January 2018 to the end of the fiscal year in which December 2019 falls.

However, if a measure is quarterly, the utility creates a row for the end of each quarter for the lifespan of
themeasure. So if themeasure life span is one FY, the utility enters 4 rows. Likewise, for a semi-annual
frequency, a measure would have two rows for each FY, and a measure with an annual frequency would
have one row for the FY.

The following example shows a section from the ObjectiveMeasureData table for an Objective with
measure #853. The active period for that measure is outlined in red. The rows in the area outlined in
green are for future periods that have no measure data yet, but do have populated target data. Because
themeasure has a monthly frequency and themeasure lifespan is set at 18months, there are 18 rows—
one for each month in the lifespan.

These prepopulated rows allow a system administrator to change the target for future time periods if the
measure’s data expectations require realignment.
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IMPORTANT: When you add a measure to an Initiative in the Initiative plan file page, data rows are
automatically created for each frequency period in the InitiativeMeasureData table when you save
the Initiative. If you want the target to be included in the data rows, you must add the target before
you save the Initiative.

When to run this utility:

l After adding a measure (with a set target) to a Perspective or an Objective
l After importing Initiatives that do not already havemeasure data rows for every period in their

measures’ active life cycles

NOTE: This utility only creates measure data rows with a populated target if they aremissing; it does
not update a changed target.

To create measure target data rows:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theData Utilities tab.

3. Click the Create Measure Data button.

4. Click theUpdate Period Measure Data button to perform calculations for the CalYTD, FiscYTD,
PrevTD and Proj.TD measure columns.

5. Click theUpdate Measure Target Status button to update the target status in the newly created
data rows.

Update measure target status
The UpdateMeasure Target Status utility automatically updates MeetsTarget column entries for all
measure data, based on theMeetsTargetDirection values set for each measure.

When you updatemeasure data in theWeb Client, themeasure target status is automatically updated
as well. However, if you manually updatemeasure data directly in a hierarchy data table—for example,
the PerspectiveMeasureData table—you would also need to manually update theMeetsTarget column
in that table for the updated data.

NOTE: Updating measures manually in the data tables is not the recommended best practice, but in
some cases may be unavoidable.

Run the UpdateMeasure Target Status utility Instead of updating target status manually. You can even
use the Axiom Scheduler (job: UpdateMeasureTarget-SQL) to automatically run this utility at set times, to
ensure themeasure data tables stay accurate. This is particularly useful if your organization has a
number of peoplemanually updating measure data in the Desktop Client.
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NOTE: This utility should not be needed when you updatemeasure data in theWeb Client’s Measure
Update Form, or when Initiative owners updatemeasure data in Initiative plan files.

� About the Update Measure Target Status utility
The utility compares the current measure data to the set measure target and determines if themeasure
data meets the target. If it meets the target or surpasses it in a favorable direction, the utility enters
“TRUE” into theMeetsTarget column for that measure data. If themeasure data does not meet the
target, the utility enters “False” into theMeetsTarget column.

In the following example, the data in the Value column matches the data in the Target column. This
means that theMeetsTarget column should be “TRUE” for themeasure, but the entry is “FALSE.”
Running the utility will change this to “TRUE.”

PerspectiveMeasureData table showing incorrect entry (FALSE) in the MeetsTarget column for the example measurement.

When to run the utility:

l When anyone updates measure data directly in a hierarchy measure data table
l After running the CreateMeasure Data utility

To update measure target status:
1. In theNavigation panel, click Admin >Maintenance.

2. In theMaintenance page, click theData Utilities tab.

3. Click theUpdate Measure Target Status button.

Update periodmeasure summary data
This utility updates period measure data values, target values, and benchmark values when present.
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This utility is also for clients who create and manage a specific class of initiatives focused on cost
reduction or revenue enhancement. For these Initiatives, you enter savings achieved each period. The
period savings represent the amount of dollars saved or paid hours reduced in an individual period.
These savings appear in the Cost Reduction Status report. To make Initiativemeasure data that you
enter in the UpdateMeasures page or the InitiativeMeasureData table available in the Cost Reduction
Status report, you must run the Update Period Measure Data utility after these Initiativemeasures are
updated.

� About the Update Period Measure Data utility
When you update cost reduction or revenue enhancement measure data in the Strategy Management
Initiativemeasure data table for an Initiativemeasure, you must also run the Update Period Measure
Data utility to update the calculated summary columns. You can even use the Axiom Scheduler (job
UpdateMeasureData-SQL) to automatically run this utility at set times to ensure the calculated data in
the summary columns in the InitiativeMeasureData table stays accurate. The job is particularly useful if
your organization has a number of peoplemanually updating cost reduction or revenue enhancement
measure data.

This utility calculates summary columns in the data tables that sum up the rolling totals by calendar year
and by fiscal year, and also sums up the rolling total from the start of each initiative. There is also a
summary calculation that stores the prior period savings. The summary columns are reportable.

When to run the utility:

l After running the CreateMeasure Data utility for imported Initiatives with measures from the PI-
Dollars-Performance Improvement class

l After running the CreateMeasure Data utility for Initiatives with cost-saving measure data
updated from the Admin Measure Update page

l After running the CreateMeasure Data utility for a new Perspectivemeasure or Objectivemeasure

To update period measure data:
1. In theNavigation panel, click Admin >Maintenance.

2. In theMaintenance page, click theData Utilities tab.

3. Click theUpdate Period Measure Data button.

Delete orphanedmeasure data
The Delete Orphan Measure Data utility removes orphaned data records that result from changes to the
hierarchy measure tables. Axiom Strategy Management administrators can use this utility to clean up
unused data and ensure that deleted measure targets do not appear in reports.
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When a hierarchy measure is first set up, the system creates individual rows in the respective
<hierarchy>MeasureData table for each time period (frequency: month, quarter, half-year, or year) in the
measure’s active period. This active period includes future dates with set targets. If that time period is
shortened, the record would have a set target for those future periods but no Actuals, which could result
in reporting errors.

When to run the utility:

l Ad-hoc – After a hierarchy measure (Perspective, Objective, Initiative) has had its active period
shortened from the original. For example, if your organization was tracking patient falls through
the end of 2020 but nowwants to change the end date to December 31, 2019.

l Scheduled – Can be set up as a Scheduler job to run at set times to ensure removal of orphaned
Initiativemeasure data.

To remove orphaned measure data:
1. In theNavigation panel, click Admin >Maintenance.

2. In theMaintenance page, click theData Utilities tab.

3. Click theDelete Orphan Measure Data button.

Update importedmeasure data actuals
For clients who have configured their systems to import actuals from other sources such as other Axiom
Software products or external data feeds, Axiom Strategy Management administrators have a utility that
updates measure data from these sources.

The UpdateMeasure Data Actuals utility runs automatically on a set basis (the default is 12:59 AM Pacific
time) to pull actuals from imported measure data stored in the staging table (MeasureDataStaging) in the
Axiom Strategy Management system. The utility updates themeasure data tables with the data and then
clears the staging table. Any data that does not match measures already in the system (matches are
performed on MeasureID, Dept, Entity, and YRMO) is moved to theMeasureDataExceptions table,
where administrators can view it using the Resolve Exceptions utility.

Administrators can also run the UpdateMeasure Data Actuals utility on an ad hoc basis.

To run the utility:
1. In theNavigation pane, click Admin >Maintenance.

2. In theMaintenance page, click theData Utilities tab.

3. On the Data Utilities page, click theUpdate Measure Data Actuals button.
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A note at the bottom of the page displays, confirming that the records have been updated from
the Staging table.

Resolve importedmeasure data exceptions
Use these instructions for resolving data mismatches that occur when measure actuals are imported to
the system.

Measure data imported to the Axiom Strategy Management system is matched by measureID, Dept,
Entity, and YRMO. If one or more of these items does not match any hierarchy measure already in the
system, the incoming data is moved to theMeasureDataExceptions table. For example, if actuals for a
given Objectivemeasure come in with an entity listed that is different from the entity listed in the
Objectivemeasure in the system, that mismatch produces a data exception.

Administrators can run the Resolve Exceptions utility to produce a report that lists themismatched data.

To resolve data mismatches:
1. In theNavigation panel, click Admin >Maintenance.

2. On theMaintenance page, click theData Utilities tab.

3. In the list of utility buttons, click the Resolve Exceptions button.

The ResolveMeasure Data Exceptions report opens, displaying a list of exceptions found .
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4. For each item, determine the type of error and take the appropriate action:
l If an item is missing from the system, add it to the system if it makes sense to do so.
l If a data item is wrong, it will need to be corrected in the originating source or removed

from the import.

5. After resolving a listed item, to remove it from the list, in the Resolved? column, click the
corresponding check box and then click Save.

The item is removed from the list. In theMeasureDataExceptions table, corrected items are
flagged as TRUE for Resolved. The user who cleared the item from the Resolved Measure Data
Exceptions report is listed in the ResolvedBy column:

The data in theMeasureDataExceptions table remains until the table is cleared and populated
with new data during the next import.
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Administering Security
The Axiom Strategy Management system administrator manages security in the Axiom Strategy
Management subsystem. To manage security, the system administrator needs to have the Security
Admin role.

NOTE: Currently, system administrators need to add users and assign user roles by accessing the
Security Management window from the Desktop Client.

Security is integrated at all levels of Axiom Strategy Management, meaning that no matter where you are
in the system, you can only view data and use features for which you have the appropriate access.

Security in the Axiom Strategy Management is based on the following:

l Logon – Allows users to log on to the system.
l Subsystem – Gives users access to one or more Axiom Healthcare Suite products licensed by your

organization.
l Role – Determines which assets you have access to. Assets include icons, tools, report, utilities,

task panes, and so on. Users may havemultiple roles. For example, a user might be an
administrator for Axiom Strategy Management but an end-user for another Axiom product.

l Filter – Restricts the data that you can view for each asset. For example, you may have access to a
specific report, but the report may only display specific information based on department.
Typically, you are restricted to your specific department or entity while administrators have
broader access.

About user roles
All user roles in Axiom Strategy Management, except the Strategy Management Administrator role, are
additive, which means you can assign a user multiple roles as needed, with each assigned role adding
rights. You can assign users as many roles as necessary to do their work, but the best practice is to add
no more rights than the user needs. The starting role for everyone but administrators is the Strategy
Management User role, which you assign to each new user as you add them to the Axiom Strategy
Management subsystem.

6
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� Axiom Everyone
This role provides access to the Axiom platform functions with which Axiom Strategy Management is
integrated. All Axiom Strategy Management users are given this role by default when you add them to
Axiom Strategy Management if they do not already have this role from having access to another Axiom
product. This role cannot be configured by the Axiom Strategy Management Admin.

� Strategy Management User
This is the baseline role in Axiom Strategy Management. All users except Strategy Management
administrators are assigned this role; it provides access to general navigation and core functionality
within theWeb Client. This role is preconfigured and should not require additional configuration after the
initial system is set up. The following tabs refer to those in the Security Management dialog accessible
from the Excel or Windows Client. Baseline access includes:

Tab Access to

Permissions None

File Groups Can query Strategy Management – Requests

Tables SMReference – Full Read access on all tables except Initiative, unless the user is
the designated owner or sponsor for an Initiative; in which case, the user has
access to only those Initiatives for which they are owner or sponsor.
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Tab Access to

Files Reports Library > Strategy Management Utilities > Home Pages

l Dashboard – Read only
o Can drill down to view details on Perspectives and Perspectivemeasures,

including measure data and KPI icons
o Can view list of Objectives but not view performance data or KPI icons,

unless the user owns the Objective

l Perspectives – Read only
o Can see all enabled Perspectives
o Can drill down to view Perspectivemeasure details but not related

Objectivemeasures
o Cannot see Baseline, Prior, Current, or Target information for related

Objectivemeasures unless the user owns the related Objective

l Objectives – Read only
o Cannot viewObjectivemeasure data or KPI icons unless the user owns

the Objective
o Cannot drill down to details unless the user owns the Objective
o Cannot view associated Initiatives unless the user is the owner or

sponsor for the Initiative

l Initiatives – Read only
o Additional Initiative role required to see Initiative names and Initiative

data, except for Initiatives the user owns or sponsors

l Admin pages – No access

� Strategy Management Executive
This role adds the following access rights to the Strategy Management User role:

l Provides full read access to Objectives, Initiatives, and measures information.
l File Groups tab – Adds Read Only access to all plan files

l Tables tab > SMReference

o Adds full Read access to the Initiative table

� Strategy Management Initiative Creator
This role adds the ability to create Initiatives and submit them for review and approval using the Initiative
Approval Process Management workflow. Only users with this role can create Initiatives in theWeb
Client. System administrators cannot create Initiatives in theWeb Client without the Initiative Creator
role. System administrators can add Initiatives in the Excel or Windows clients using the import Initiatives
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utility.

NOTE: This role requires the user to have either the Strategy Management User role or the Strategy
Management Admin role.

� Strategy Management Initiative Owner
This is not strictly a “user role” because it is not managed in the system security settings, it is assigned by
the Initiative creator when they create the Initiative. This adjunct role enables the user to review and
modify an Initiative when it is in the Owner Review stage of the Initiative creation approval process, to
update an Initiative’s measure data and milestone status when the Initiative is in the Active Tracking
stage of the Initiative update approval process, and to approve an Initiative as Complete in the Pending
Reset stage of the Initiative completion process. An Initiative owner can also abort an Initiative at the
Active Tracking step in the Initiative creation approval process and the Initiative update approval
process.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

� Strategy Management Initiative Sponsor
This is not strictly a “user role” because it is not managed in the system security settings, it is assigned by
the Initiative creator when they create the Initiative. This adjunct role enables the user to review and
modify an Initiative when it is in the Sponsor Review stage of the Initiative creation approval process.
This role also enables the user to review and approve Initiativemeasure data in the Active Review stage
of the Initiative update approval process.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

� Strategy Management Initiative Approver
This role enables the user to approve Initiatives into the Active Tracking stage of the Initiative Approval
Process Management workflow, or to reject or abort Initiatives. This role also enables the user to view
comments and submission history for Initiatives.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

This user role adds the following rights:
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Tab Access to

File l Dashboard – Read only
o Can see Subscribed Initiatives in list
o Can access Initiatives approval process task page

l Perspectives – Read only
o Can see all Initiatives related to each Objective and can click to access

Initiative-related pages

l Objectives – Read only
o Can see all Initiative information and click to access Initiative-related

pages (but still cannot see Objectivemeasure data unless user is
Objective owner)

l Initiatives – Read only
o Can see all Initiative names and Initiative summary data
o Cannot create an Initiative
o Can click to go to Initiative plan file page, approval process routing page

� Strategy Management Admin
This role grants the user master system user access, including access to all Axiom Strategy Management
tools and tables from the Excel or Windows Client. This role does not require the Strategy Management
User role be assigned in addition. This role does not provide the ability to assign roles to users.

Tab Access to

Permissions l Administer announcements
l Administer Axiom Explorer
l Administer tables
l Scheduled jobs user (can use Scheduler in Desktop Client for the following

jobs: SM_CreatePlanFiles, UpdateMeasureData-SQL, and
UpdateMeasureTarget-SQL)

File Groups Can query Strategy Management – Requests

l Create Plan Files (in the Excel and Windows clients)
l Create new records
l Run Axiom Queries

Tables SMReference – Full access

Data – Full access
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Tab Access to

Files Reports Library > Strategy Management Utilities > Home Pages

l Objectives – Full Read access
l Initiatives – Full Read access
l Admin pages – Full access

� Security Admin
This role grants the user the ability to add users to the Axiom Axiom subsystem and to assign other
Strategy Management roles.

l Permissions tab
o Administer Security – Security Management utility for managing users, user roles, and

access to the Axiom Strategy Management subsystem

Add a user
Use these instructions to add a user to Axiom Strategy Management. Every user is first assigned the
Strategy Management User role unless that user is assigned the Strategy Management Administrator
role.

NOTE: You must have the Security Admin role to be able to access the Security Manager and assign
roles to users.

To add a user to Axiom Strategy Management:
1. Launch the Desktop Client.

2. In the Ribbon, click theMAIN tab.

3. In the Security section, click Security Manager.

4. In the top left corner of the Security Management dialog, click Users.

5. At the bottom left of the dialog below the list of users, click the Create user plus ( ) icon.

6. In theUser Details section of theGeneral tab, add the user’s information. For information, go to
the Axiom Desktop Client help and search on “defining user properties.”

7. At the bottom right of the Security Management dialog, click Apply.

NOTE: You cannot assign roles or a subsystem to the user until you click Apply.

8. In the Assigned Roles section, click the Add plus ( ) icon.

9. In the Assign Roles dialog:
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a. Scroll to the bottom of the Available Roles column and click Strategy Management User.

b. Click Add to move the role to the Assigned Roles column.

c. Click OK.

10. In the Assigned Subsystems section, click the Add plus ( ) icon.

11. In the Available Subsystems column of the Assign Subsystems dialog:
a. Click Strategy Management.

b. Click Add to move it to the Assigned Subsystems column.

c. Click OK.

12. Click Apply.

13. Click OK.

Assign roles to users
You can assign roles to a user at any time after adding the user to the Axiom Strategy Management
subsystem and giving them the Strategy Management User Role in the Security Management utility.

These instructions assume that the user already has the Security Management User role and has been
added to the subsystem.

NOTE: You must have the Security Admin role to be able to assign roles to users.

To assign roles to a user:
1. Launch the Desktop Client.

2. In the Ribbon, click theMAIN tab.

3. In the Security section, click Security Manager.

4. In the top left corner of the Security Management dialog, click Users.

5. Locate and select the user in the list of names.

NOTE: If the list is long, you can clear theDisabled check box to view only active users, or you
can type the user’s name in the search field above the list.

6. In the Assigned Roles section of theGeneral tab, click the Add plus ( ) icon.

7. In the Assign Roles dialog:
a. Scroll to the bottom of the Available Roles column and select the desired role.

b. Click Add to move the role to the Assigned Roles column.

Administrator's Guide Axiom Strategy Management │ 98



c. Repeat until you have added all the desired roles for the user.

d. Click OK

8. Click Apply.

9. Click OK.
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Reference
This appendix contains reference information for administrators configuring and maintaining Axiom
Axiom.

Launch the Desktop (Excel orWindows) Client
Use the following instructions to launch either theWindows Client or the Excel Client from Axiom
Strategy Management.

To launch one of the spreadsheet clients:

1. In the Global Navigation bar (blue bar at top of page), click the Quick Launch icon ( ).

2. In theQuick Launch menu, click the desired Desktop Client (Windows or Excel).

The application launches.

A
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Get Perspective icons
Axiom Strategy Management uses free icons from Font Awesome. Only icon names from Font Awesome
will work.

1. Go to Font Awesome and search for the icon you want or review the available lists.

2. Locate the desired icon in the list and click it. A new page opens for that icon. The code for the icon
displays below a picture of the icon.

3. Use your cursor to highlight just the code, as shown in the following example.

4. Right-click the highlighted name, and select Copy.

5. In Axiom Strategy Management, navigate to the desired Icon field, place your cursor in the field,
right-click and select Paste.

6. Click Save.
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About measures
Axiom Strategy Management uses data collectors calledmeasures to determine how the items in the
strategy hierarchy—Perspectives, Objectives, and Initiatives—are performing currently and over time.

Each measure captures specific data. For example, if an Objective is to improve patient access to care,
you could assign a measure that records the average time it takes for a patient to schedule a primary
care visit.

Measure data is updated on a regular schedule according to themeasure’s frequency; the default is
monthly. The system administrator updates Perspective and Objectivemeasure data. Initiativemeasure
data is typically updated by the Initiative owner, or an administrator can also update them if needed.

Each measure has some or all of the following attributes:

l Description –Measure name
l GL Acct – General Ledger account in which themeasure belongs
l Precision – The number of decimal values that display for units when the system displays measure

data in Measure Detail windows
l Class – Category in which themeasure belongs
l Type –Method used for updating themeasure
l Unit – Format type of the data themeasure produces (i.e., amount for currencies, percent for

percentages, number for other numeric data)
l Frequency – Howoften themeasure data is updated and reported
l Formula Description – Optional. How themeasure data is derived, if applicable
l User Drill – Optional. Indicates themeasure has an associated drill document
l Enabled / Disabled –Whether or not themeasure is available to be selected for hierarchy items

(Perspectives, Objectives, and Initiatives)
l MeetsTargetDirection – Direction of themeasured data (higher or lower) that is favorable when

the data is compared to the set target

When measures are assigned to Perspectives, Objectives, or Initiatives, they receive the following
additional attributes:

l Baseline – Starting point at which data measurements begin. This can be from the current year or
a historical average for the past 12months.

l Target – The number used as a comparison point against which measure data is compared to
determine if the data is favorable or unfavorable. The person assigning themeasure to a
Perspective, Objective, or Initiative, sets the target. The target typically comes from either a
benchmarked or budgeted number.

l Period Begin – (Called Start Date in Initiativemeasures) The starting date for which measure data
is collected and recorded. This date typically coincides with the start date of the Initiative.
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l Period End – (Called End Date in Initiativemeasures) The datemeasurement data stops being
collected and recorded.

l Department – Optional. The department from which themeasure data is taken
l Entity – Optional. If a department is selected, then the entity is the higher-level section of the

organization (e.g., location, building), or the organization itself, that the department belongs to. If
no department is specified, then the entity is the part of the organization or the entire
organization from which themeasure data is taken.

About Key Performance Indicator icons
Axiom Strategy Management displays Key Performance Indicator (KPI) icons to represent current status
as compared with set targets and to show period-over-period trends. KPIs usemeasurements of active
data to reflect whether the hierarchy item they apply to is performing favorably, unfavorably, or a mix of
both, as compared to the target set in the item’s measure.

How the system determines KPI icon use
The system displays KPI icons to provide at-a-glance performance status for Perspectives, Objectives,
and Initiatives. Perspective and Objective KPIs reflect their measure data. Initiatives are different in that
their KPI icons represent the status of their milestones. For more information, see About Initiative
milestones.

KPI icons represent a value judgment of whether the data measured is favorable or unfavorable
compared to the target set in themeasure when themeasure is applied to a Perspective or Objective.

Measured data can be higher than, lower than, or right on the target. Whether data above the target or
below the target is favorable or unfavorable depends on what is being measured. For example, when
measuring profitability, data above the target is favorable. However, if themeasure tracks the number of
patient falls, then your target would be themaximum number of falls considered acceptable in a period,
and a number at or below the target would be favorable. The direction of the data—above or below the
target—that is favorable, is called theMeetsTargetDirection attribute. TheMeetsTargetDirection
attribute is defined when themeasure is created.

In the following example, a Perspectivemeasure tracks the AHRQ Patient Safety Indicator Composite for
serious complications. For this measure, theMeetsTargetDirection is set to Lower. The target is set to the
number 50. The current measurement is 47, which is lower than the set target, so the current
measurement is favorable. The icon used to represent themeasure’s current performance is called a
performance icon. In this case, because the performance is favorable, the icon used is a check mark in a
green circle.
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Notice that the current measurement is lower than the prior measurement, which indicates improved
performance over time. In Axiom Strategy Management, performance over time is called trend. When
data is moving in a favorable direction from the previous measurement, the trend is favorable, which is
represented by a green, up arrow icon.

Icons and icon colors indicate status: a check mark indicates favorable, an exclamation mark indicates
unfavorable. Green represents favorable data, and red represents unfavorable data. Orange indicates
the status is a mixture of favorable and unfavorable data if the icon is a performance icon. For a trend
icon, orange indicates the trend is flat, meaning it is moving neither favorably nor unfavorably as
compared to the previous frequency period measurement.

The following example of the list of Objectives from the Dashboard page displays each Objective’s KPI
and trend icons.

For detailed descriptions of each icon used in the system, see the following tables.
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Key Performance Indicator icons
Axiom Strategy Management uses two kinds of KPI icons: performance and trend. Performance icons
come in two types: single-measure and roll-up measure. Single-measure icons reflect the status of a
single measure, whereas roll-up measure icons reflect a combination of two or moremeasures.

� Performance icons for hierarchy measures
This table lists the performance icons used for Perspective, Objective, and Initiativemeasures.
Performance icons represent the status ofmeasurements for a single frequency period.

Icon Meaning

This icon indicates the hierarchy item’s measure is performing favorably compared to
the set target. The system displays this icon to represent the performance of a single
measurement or multiple measurements that are performing favorably.

This roll-up icon indicates that the hierarchy item’s measure performance is a mix of
favorable and unfavorablemeasurements compared to the set target.

This icon always represents a roll-up measurement. This icon also always represents a
mix of favorable and unfavorablemeasurements for the item being measured,
regardless of howmany of themeasurements are favorable or unfavorable. For
example, if a Perspective has four measures and three of them are favorable and one is
unfavorable, this performance icon is used; likewise, if three of themeasures are
unfavorable and one is favorable.

This icon indicates that the item is performing unfavorably compared to the target. The
system displays this icon to represent the performance of a single measurement or
multiple measurements that are all performing unfavorably.

This icon indicates that either no data is available for the item or that you do not have
permissions to view that data.

� Trend icons for hierarchy measures
Trending is determined by comparing themeasure value of the current frequency period to the previous
frequency period. In the case of roll-up measures, this is evaluated by comparing the previous period
performance (i.e. green, red, orange) to the current period performance. Trend icons apply only to
measure data performance, not Initiativemilestone performance.

Icon Meaning

The item is trending favorably. This means the performance is headed in a favorable
direction compared to the previous measurement.

Administrator's Guide Axiom Strategy Management │ 105



Icon Meaning

The item is trending flat. This means the performance is trending neither favorably nor
unfavorably compared to the previous measurement.

The item is trending unfavorably. This means the performance is headed in an unfavorable
direction compared to the previous measurement.

The item contains no data, or you do not have permissions to view the data.

Icon combinations
The following table lists the possible performance-trend icon combinations and their meaning.

Icon set Meaning

Performance is favorable compared to the target, and trending favorably compared
to the previous measurement.

Performance is favorable compared to the target, and trending flat, neither up nor
down, compared to the previous measurement.

Performance is currently favorable compared to the target, but trending
unfavorably.

Performance is a mixture of favorable and unfavorablemeasurements compared to
the target, and is trending favorably compared to the previous measurement.

Performance is a mixture of favorable and unfavorablemeasurements compared to
the target, and is trending flat compared to the previous measurement.

Performance is a mixture of favorable and unfavorablemeasurements compared to
the target, and is trending unfavorably compared to the previous measurement.

Performance is unfavorable compared to the target, and trending favorably
compared to the previous measurement.

Performance is unfavorable compared to the target, and trending flat compared to
the previous measurement.

Performance is unfavorable compared to the target, and trending unfavorably
compared to the previous measurement.

There is no performance or trend data available for the item, or you do not have
permissions to view the data.

Administrator's Guide Axiom Strategy Management │ 106



About Initiative milestones
When creating an Initiative, users can set milestones to track the life cycle of the Initiative. Milestones
provide a way to ensure that the Initiative project gets launched on time, that work gets done according
to schedule, and that Initiatives are completed on time. Milestones are tracked monthly.

Unlike Perspectives and Objectives, Initiatives do not have begin and end dates; instead, an Initiative’s
life cycle begins at creation and ends when all of its milestones are complete and the Initiative no longer
needs to collect measure data. However, since an Initiative supports an Objective, the Initiative’s
milestone time frames need to fall within the associated Objective’s Period Begin and Period End dates.
To ensure this happens, each newly-created Initiative comes with two built-in milestones:

l Initiative Kickoff – Uses the current date as themilestone’s start date.
l Initiative Completion – Uses the last day of themonth of the Period End date of the associated

Objective as themilestone’s start and end dates. For example, if the Objective Period End date is
June 2021, the Initiative Completion milestone dates will be June 30, 2021.

NOTE: The system only displays Objective dates on the Admin Maintenance page to system
administrators.

Before submitting the Initiative for approval, if you delete both of these Initiatives without adding any
others, save the file and then go back to the plan file page, the default Initiatives will be restored.
(However, if themilestones are deleted during the owner or sponsor review stages, the Initiatives are not
restored.) This is a safeguard to prevent creating Initiatives with no milestones. While you can save an
Initiative without milestones, the best practice recommendation is to have at least oneMilestone per
Initiative. This is especially important because Initiative status is derived from milestone status. You do
not have to add all themilestones before submitting the Initiative for approval; the Initiative owner or
sponsor can add milestones before the Initiative is approved to active tracking.

After the Initiative has been approved to the Active Tracking stage, Initiative owners and sponsors can
update the status ofmilestones.

� Milestone status
When the system displays an overall Status for an Initiative on the Initiatives page, it uses themost
recent status of the Initiative’s milestones. However, themilestone status displayed in the Status column
on the Initiatives page is not an aggregation of the Initiative’s milestones; rather, the system checks the
status of all the Initiative’s milestones and if there is a problem with any of them, the system displays the
status that is themost urgent.

For example, if any milestones have the status of Needs Attention, then this is the status that displays in
the Status column, even if the other milestones are On Track or Completed. However, if another one of
the Initiative’s milestones has the status At Risk, then this is the status that displays because At Risk is a
higher level of urgency than Needs Attention. This feature allows you to see immediately which Initiatives
need help to get back on track.
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Milestone status icons

Initiativemilestone status is represented using KPI icons but no trend icons. When the dash icon ( ) is
used to represent milestone status, it indicates that there is no milestone data. No milestone data
usually indicates that the Initiative has not reached the Active Tracking stage in the Initiative creation
approval process.
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